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Preface

Understand audience, know related documents and products and conventions followed in

this document.

Intended Audience

This user guide is for plant maintenance field service technicians in your organization.
The user guide familiarizes operators or technicians with features and functionality of the
Connected Back Office solution.

Document Conventions

Table 0-1 Conventions followed in the document

Convention Meaning

boldface ) ) )
Indicates graphical user interface elements

associated with an action, or terms defined

in text or the glossary.

italic
Indicates book titles, emphasis, or place-
holder variables for which you supply values.

nonospace . Lo
Indicates commands within a paragraph,

URLs, code in examples, text that appears on
the screen, or text that you enter

Related Products & Solutions

» Work Order Management
* Inventory and Warehouse Management

+ Analytics and Dashboards

Contact Innovapptive

For information on Innovapptive products, visit the Innovapptive’s Support Portal at http://
helpdesk.innovapptive.com. The updates to this document are published on this support
portal. Check this website periodically for updated documentation.


https://www.innovapptive.com/solutions/work-order-management
https://www.innovapptive.com/solutions/inventory-and-warehouse-management
https://www.innovapptive.com/solutions/analytics-dashboards
http://helpdesk.innovapptive.com/
http://helpdesk.innovapptive.com/

For additional information about this document, send an email to

documentation@innovapptive.com.


mailto:documentation@innovapptive.com
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1. Introduction

The iMaintenance Configuration Guide is your blueprint for shaping how iMaintenance works
in your organization.

Once the product is deployed, this guide helps you transform the out-of-the-box system into

a solution tailored to your business processes, plants, and teams.

Unlike installation or deployment activities that live with IT, the configurations in this guide are
what bring iMaintenance to life for end users. From onboarding tenants and defining identity
providers, to managing users and roles, setting up master data, and enabling core modules
like Work Orders, Issues, and Timesheets — every section of this guide is designed to help you
align iMaintenance with the way your organization runs maintenance.

With this guide, you will:

- Establish the foundation — onboard your tenant, configure authentication, and set up

users and master data.

« Control product behavior — decide which modules are available, how Work Orders
flow, and how Al, timers, and measuring points are applied.

« Integrate and extend — connect to ERP systems, define MCC behavior, and configure
observation handling.

« Customize and optimize — design forms, create RACE templates, define risk matrices,
set notifications, and personalize platform settings.

- Drive insights — configure dashboards and reports that turn operational data into

decision-ready intelligence.

Whether you are an administrator, functional lead, or supervisor, this guide gives you the
controls to tune iMaintenance so it mirrors your organization’s rules, safety requirements, and
productivity goals — without touching the underlying infrastructure.

1.1. About the Configuration Platform

The iMaintenance Configuration Console is the web admin layer that lets your organization

shape how iMaintenance behaves—without code.

iMaintenance Configuration Guide 8



| 1- Introduction

From one place, functional admins define modules, map forms, enforce validations, and set
product-wide defaults so technicians and supervisors get a clean, consistent experience in
the field.

What you can do here:

+ Manage Core Modules: Enable/disable Issues, Work Orders, and Timesheets at tenant
or plant level.

- Control Work Order Behavior: Auto timers, raise issue at submission, follow-up issues,
operation confirmation, RCA, measuring points.

- Design Data Capture: Build forms/templates, add conditional logic, field rules, and
validations.

- Assign by Hierarchy: Map forms and settings to plants, locations, units, or teams.

- Set Global Defaults: Session timeout, chat, attachments/DMS, list templates, key
mappings.

- Administer Access: Create users and groups, assign roles/permissions, enforce
governance.

« Connect Systems (Ul side): Configure ERP connections and other integrations exposed
in the console.

« Publish Insights: Configure dashboards and reports used across the org.

Who should use this

- Functional Administrators [ Doc Owners — primary audience. They own templates,
module controls, business rules, and access policies.

- IT [ Basis (as-needed support) — assists when a configuration requires backend
application (e.g., DB-stored flags), SSO/IDP wiring, or transport/security steps
documented in the Deployment & Setup Guide.

If you execute work (creote/complete WOs, inspections, timesheets), see the
User Guides. If you shape how iMaintenance works, you're in the right place.

n
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1.2. What's New for Configuration

This section highlights the latest features and enhancements introduced across recent

iMaintenance configuration release.

* New Features and Enhancements in Release 2604 (on page 10)
« New Features and Enhancements in Release 2511 (on page 10)

» New Features and Enhancements in Release 2510 (on page 12)
New Features and Enhancements in Release 2604

Table 1-1 New Features and Enhancements in Release 2604

Issue Slip Template Configuration for Structured Data Capture (Web App)

Administrators can now configure Issue Slip templates from the web application, enabling
structured and standardized data capture during material issuance. When technicians ini-
tiate an Issue Slip from the mobile app, the configured template is dynamically displayed
within the Components screen, ensuring consistent and complete information collection.

For more information, see Configure Issue Slip Template (on page 112).

New Features and Enhancements in Release 2511

Table 1-2 New Features and Enhancements in Release 2511

Configure MCC Field Visibility Based on Templates (Web App)

Allow administrators to view and manage field configurations in the Maintenance Con-
trol Center based on Work Order or Operation templates defined in RACE. Add or remove
fields from the MCC display without affecting mobile application behavior. The configura-
tion dynamically reflects template-level settings while clearly distinguishing between tem-
plate-level and field-level options.

For more information, see Manage Maintenance Operations (on page 83).

Manage Operation-Level Resources Directly in MCC (Web App)

iMaintenance Configuration Guide
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Table 1-2 New Features and Enhancements in Release 2511 (continued)

Add or remove resources for individual operations directly from MCC operation cards with-
out navigating away from the main view. Assign technicians to resource slots inline and
watch resource counts update automatically as changes are made. All modifications sync
to SAP and mobile applications in real-time when saved.

For more information, see Assign a Work Order at Header and Operation Level (on page
85).

Filter Resource Dropdown by Plant in MCC (Web App)

Fetch resource data in the MCC assignment dropdown based on the Plant instead of the
Work Center. This change supports organizations that assign technicians to Personal Areas
and need plant-based filtering to display the correct resource list during operation assign-
ments.

For more information, see Assign a Work Order at Header and Operation Level (on page
85).

Enable or Disable Assignment Options from Tenant Configuration (Web App)

Configure whether the Assign call-to-action appears at the Work Order level, Operation lev-
el, both, or neither through tenant configuration settings. This flexibility accommodates dif-
ferent customer workflows where some prefer header-level assignments while others re-
quire operation-level granularity. The Ul dynamically reflects configuration changes while
respecting existing control key rules at the operation level.

Configure ERP-Aware User Upload for SAP and Maximo Tenants (Web App)

Define tenant-level configuration settings that control how user data is onboarded based
on your ERP type. SAP tenants see the Excel upload option for manual user management
while Maximo tenants have this option disabled with user data fetched directly from the ERP.
Configuration changes take effect in real-time after cache refresh.

Support Special Characters in MongoDB Keys (Web App)

iMaintenance Configuration Guide 1
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Table 1-2 New Features and Enhancements in Release 2511 (continued)

Handle special characters such as dots and dollar signs in MongoDB document keys when
integrating with third-party systems or processing user-generated data. This technical en-
hancement prevents data storage failures and ensures smooth interoperability with exter-
nal systems that may include special characters in their data structures.

Configure Default Values for Text Response Fields (Web App)

Set default values for text response type fields in template configurations. When technicians
open a form, the configured default values appear pre-filled in the appropriate fields. This
reduces repetitive data entry and ensures standardized responses across the organization.

For more information, see Create and Publish Forms (on page 90).

Improved Global Picklist Performance with Caching and Indexing (Web App)

Accelerate Global Picklist loading through implementation of caching and database index-
ing optimizations. Since the Global Picklist is used across multiple modules, these perfor-
mance improvements reduce response times throughout the application.

For more information, see Create and Publish Forms (on page 90).

Enhanced Session Management (Web App)

Introduce a unified session control mechanism that ensures only one active session per
user across devices. When a user attempts to log in from a new device, the system checks
for any existing active sessions and prompts the user with an action choice.

New Features and Enhancements in Release 2510

Table 1-3 New Features and Enhancements in Release 2510

Enhance Accuracy in Al-Driven Forms

Enhance the reliability and precision of Al-driven form generation and field predictions
within the iMaintenance application. The upgraded Al model now delivers more accurate
field mappings, validations, and context-aware suggestions—reducing manual corrections
and ensuring data consistency across forms.

iMaintenance Configuration Guide 12
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Table 1-3 New Features and Enhancements in Release 2510 (continued)
For more information, see Create and Publish Forms (on page 90).

Embedded Forms Integration with SAP

Post Embedded Forms created in the Platform to SAP seamlessly, ensuring that any form
filled via mobile or web is automatically captured in SAP. Admins can configure which forms
are eligible for posting and manage integration settings for specific processes, enabling re-
al-time data synchronization and smooth business process alignment.

For more information, see Create and Publish Forms (on page 90).

Work Order Filtering by Revision and Planner Group

Enable precise Work Order retrieval in the Maintenance Control Center by applying Revision
and Planner Group filters. Users can quickly fetch relevant Work Orders based on the select-
ed criteria, ensuring targeted data access and streamlined workflow management.

For more information, see Use the Maintenance Control Center (MCC) (on page 83).

Enhanced Plant Creation in Plant Management

Admins can now create a new Plant with Planning and Maintenance Plant types. The Create
and Edit Plant panels include the new option in the Plant Type drop-down, enabling con-
figuration of plants that don't fit traditional categories for greater flexibility and real-world
alignment.

For more information, see Create a Plant (on page 50).

Risk Matrix Enhancement — Map Risk Levels to ABC Criticality

Enhance the Risk Matrix feature to allow mapping of Risk Level values (Very High, High, Medi-
um, Low) to ABC Criticality indicators (A, B, C) per Plant and Issue/Work Order. Plant Admins
or Process Owners can define plant-specific logic, ensuring that Risk Matrix outputs align
with operational criticality for consistent and automated prioritization.

For more information, see Configure Risk Evaluation with the Risk Matrix (on page 127).

Enhance Risk Matrix Priorities

iMaintenance Configuration Guide 13
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Table 1-3 New Features and Enhancements in Release 2510 (continued)

Define Issue and Work Order priorities using the Risk Matrix and synchronize them seamless-
ly with SAP. Supervisors can create plant-specific templates, assign consequence and like-
lihood scenarios, and set priority names with time values. Integration ensures that priorities
remain consistent whether an Issue/Work Order is raised in Innovapptive or SAP, streamlin-
ing risk-based decision-making.

For more information, see Configure Risk Evaluation with the Risk Matrix (on page 127).

Insert Image Response Type in Forms

Admins can now use the Insert Image response type in the Forms module to upload a single
image directly from their device into a form field. This feature enables visual context in issue
reporting and workflows, allowing annotated diagrams, reference charts, or schematics to
be added easily, improving clarity and accelerating review processes.

For more information, see Create and Publish Forms (on page 90).

Control Risk Matrix and Priority Field Behavior Based on Configuration

Maintain consistency and prevent configuration errors with enhanced control over Risk Ma-
trix and Priority Field behavior. When the Risk Matrix is disabled at the tenant level, its re-
sponse type is automatically deactivated, and users are prompted to update any affect-
ed templates. The Priority field now dynamically adjusts based on the selected Issue Type or
Work Order Type, ensuring only valid priority options are displayed according to system or
template-level configurations.

View System Status, User Status, and Priority in Asset 360 Dashboard

Enhance visibility and consistency with the addition of System Status, User Status, and Prior-
ity fields directly in the Asset 360 Dashboard list view. Users can now quickly view key status
details under the Issues and Work Orders sections without navigating to separate lists. The
displayed information aligns exactly with the individual Issues and Work Orders list views,
ensuring a consistent experience across both web and mobile platforms.

For more information, see View the Asset360 Dashboard (on page 137).

Configurable Field Management for MCC via RACE

iMaintenance Configuration Guide 14
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Table 1-3 New Features and Enhancements in Release 2510 (continued)

Enable administrators to view, add, or remove fields in the Maintenance Control Center
(McCcC) Field Configuration based on templates defined in RACE, without affecting existing
mobile implementations. This enhancement replaces the static setup with a dynamic con-
figuration, ensuring that MCC displays data aligned with template-specific Work Orders

and Operations.

For more information, see Use the Maintenance Control Center (MCC) (on page 83).

Real-Time Push Alerts for Tagged Messages

Receive instant push notifications whenever you are tagged using @mention in the chat.
This ensures you are promptly alerted to messages that require your attention, enabling
faster responses and improved collaboration.

Ensure Every Operation Has a Unit of Measurement

Al-suggested operations now always include a Unit of Measurement (UOM). Legacy opera-
tions are automatically backfilled with appropriate UOMs.

For more information, see Create and Publish Forms (on page 90).

Integrate UOM with Number Fields

When adding Number response types to forms, you can pull Units of Measurement directly
from master data. These values stay aligned with enterprise standards.

For more information, see Create and Publish Forms (on page 90).

Start New Deployments with Updated Out of the Box (OOTB) Data

Seed data scripts for both Platform (Configuration) and iMaintenance have been refreshed
to match the latest templates and functional updates.

Enable Enterprise Authentication with Okta SSO

You can enable Okta-based Single Sign-On (SSO) so that users log in with their corporate

credentials.

iMaintenance Configuration Guide
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Table 1-3 New Features and Enhancements in Release 2510 (continued)
For more information, see Log in to Platform Application (on page 19).

Control Chat Visibility by Tenant or Module

You can define where chat is available—at the tenant level, within specific modules (Work
Order, Issue).

For more information, see Customer Tenant Onboarding with Azure IDP (on page 23).

Make Workcenter Optional in Bulk User Uploads

The Workcenter field is now optional during bulk user creation via Excel upload, matching
the behavior of manual user creation.

For more information, see Bulk Upload Users (on page 49).

Create Forms Directly from Excel Templates

You can download a pre-defined Excel template, fill in form fields offline, and upload it back
into the platform to automatically generate a form.

For more information, see Bulk Upload Forms (on page 102).

Auto-Assign Forms Based on Configurable Rules

You can define rules to automatically assign embedded forms based on Work Order type,
Equipment, Functional Location, Notification, Task List, Maintenance Plan, Order Type, DMS, or
PRT.

For more information, see Auto Assign Forms (on page 95).

Configure Pre-Filled Fields in Forms

Form authors can now define which fields are auto-populated when creating a form, with
full control over field properties such as editable or read-only.

For more information, see Create and Publish Forms (on page 90).

iMaintenance Configuration Guide 16
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Table 1-3 New Features and Enhancements in Release 2510 (continued)

Show Clearer SAP Sync Status

The platform now provides explicit push notifications for SAP sync. Successful number gen-
eration is confirmed, while failed syncs show an "Unsuccessful Sync” message.

Auto-Assign Forms to SAP Work Orders

You can map forms in RACE by Equipment, Functional Location, Work Order Type, Task List, or
Maintenance Plan. Once a Work Order syncs from SAP, the mapped forms are attached au-
tomatically.

Streamline Material Collection in the Field

The enhanced Components tab supports recording materials against operations, posting
updates to SAP in real time. It allows bulk or per-operation entries, partial or full goods is-
sues, returns, and material reuse.

Add Visual Guidance with Icons and Images in Instruction Response Type
You can embed icons and images directly into Instruction response types within forms.

For more information, see Create and Publish Forms (on page 90).

Improve Layout Clarity and Auto-Save Feedback

The authoring interface now displays plant details under form titles, uses clearer section
layouts, and shows real-time auto-save status. Al-driven form creation includes expanded
instance selection options.

For more information, see Create and Publish Forms (on page 90).

Add Dedicated Measuring Point Sections

You can insert a dedicated Measuring Point (MP) section in forms, by selecting Equipment
and Functional Location or both.

For more information, see Create and Publish Forms (on page 90).

iMaintenance Configuration Guide 17
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Table 1-3 New Features and Enhancements in Release 2510 (continued)

Track Al-Generated Forms with Form Numbers

Al-generated forms now display an assigned Form Number, just like manually authored
forms.

For more information, see Create and Publish Forms (on page 90).

Auto-Populate Forms from Photos

Users can upload an image with a form ID, and the system extracts content using OCR,
mapping it to the correct fields with Al-based logic.

For more information, see Create and Publish Forms (on page 90).

Improve Text Extraction with OCR Pre-Processing

Uploaded forms are now processed with Optical Character Recognition (OCR) before being
sent to the LLM. Both OCR output and the original PDF are passed through for improved ac-
curacy.

Connect to Centralized Al Services

Al-Assist services now run within the AlServer workspace, with consuming services connect-
ing dynamically.

Sort Work Orders by Basic Start Date

You can configure the Work Order list in Maintenance Control Center (Mcc) to always sort
by Basic Start Date across all categories.

For more information, see Use the Maintenance Control Center (MCC) (on page 83).

Create Objects and Issues Without Switching Contexts

From an existing Work Order, you can now create or update Objects, and also generate Is-
sues from those Objects—all without leaving the Work Order screen.

iMaintenance Configuration Guide 18
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2. Log in to Application

This chapter has the following topics:

* Log in to Platform Application (on page 19)
« Troubleshoot Login Issues (on page 20)

2.1. Log in to Platform Application

You can access the platform using multiple login methods based on your organization’s
configuration.

Basic Authentication

Use your company registered email and password to log in.

1. Open the application.

2. Enter your Email Address and Password.

3. Click signiin.

4. Select Remember me to save login credentials. (Optional)

Sign in

Company Email Address

Single Sign-On (SSO: Google or Microsoft)

You can also sign in using your Google or Microsoft account—whichever is enabled for your
organization.

iMaintenance Configuration Guide 19
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1. On the login screen, click Sign in with Google or Sign in with Microsoft.
2. Select or enter your account credentials.

(g N
Note:
If this is your first time, the same button completes your sign-up process. If your
browser has saved Google or Microsoft accounts, they will appear automatically

for quicker selection.
- J

2.2. Troubleshoot Login Issues

If you forget your password:

1. Navigate to the Signin page.
2. Click Forgot Password?
3. Enter your registered email and click Continue.

Reset your password

Enter the email ID associated with your account and we will send
an email to reset your password.

Email

Continue

4. If two-factor authentication is enabled, verify using the code sent to your phone.
5. Follow the email link to set a new password.

iMaintenance Configuration Guide 20
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3. Navigate to the iMaintenance Configuration

This section helps you get familiar with the layout of the platform and how to access various
modules efficiently.

This chapter has the following topics:

» Explore the Home Screen (on page 21)
» Access Modules (on page 22)
» Understanding the Platform Layout (on page 22)

3.1. Explore the Home Screen

This section helps you get familiar with the layout of the platform and how to access various
modules efficiently.

After logging in, you are directed to the Home Screen, which acts as the central hub for all
platform activity. From here, you can:

« Track specific plants and assets’ performance.

« View key widgets and summaries.

» Access dashboards and reports.

« Use the left-hand navigation panel for quick access to modules such as Maintenance
Control Center (MCC), Observations, Forms, and more.

Z INNOVAPPTIVE Reports Z INNOVAPPTIVE
N7 Dashboard > Reports
m DASHBOARD v _r
Recent Favorite Al 6Reports  Q_ Search by Name/Description = Create Report
E: 1| PERMITS v
Module 11 Description 11 Modified By 11 Modified On 1 Actions
N,
>3 MAINTENANCE CONTROL CENTER
WorkOrder nnnf Jayaraju Metta 30 May 2025, 11:26 AM Yo e
B OBSERVATIONS
WorkOrder nnnf Jayaraju Metta 30 May 2025, 11:26 AM
2 USER MANAGEMENT v
WorkOrder order Siddhi Wadetiwar 30 May 2025, 11:26 AM
*, Al STUDIO v
WorkOrder created on 29th May Arya D 30 May 2025, 11:26 AM
S MASTER DATA v . .
S Components testing Vivek Kale 29 May 2025, 10:40 AM
S A
A RACE v Issue test Siddhi Wadetiwar 29 May 2025, 10:40 AM

Version 8.08

The layout is designed for ease of use, with consistent elements across modules for a
smoother user experience.

iMaintenance Configuration Guide
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3.2. Access Modules

Modules represent different functional areas of the platform (e.g., MCC, Observations, Forms,

RACE, Settings).

To access a module:

1. Use the left navigation pane to browse through available modules.

2. Click a module name (e.g., Maintenance Control Center) to open it.

3. Sub-menus, if any, will expand below the selected module.

Some modules may only appear based on your role and access permissions.

Tip: Hover over icons in the side panel to view full module names if the menu is

collapsed.

3.3. Understand the Platform Layout

The platform interface is made up of the following key areas:

Area

Description

Header Bar

Located at the top, it includes user profile
options, notifications, and product/version
details.

Navigation Panel (Left Sidebar)

Lets you access different modules, features,
and configuration options.

Main Workspace

The center of the screen where dashboards,
forms, reports, and module content are dis-
played.

Filters and Actions (Top of Workspace)

Contextual filters, search bars, and action
buttons are available based on the module
in use.

The interface is consistent across modules to make navigation intuitive and user-friendly.

iMaintenance Configuration Guide
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4. Customer Tenant Onboarding with Azure IDP

This chapter provides step-by-step instructions to configure a customer’s Azure Active

Directory (Azure AD) for federated Single Sign-On (SSO) with Innovapptive mobile

applications. It applies to IT administrators and implementation engineers performing

customer onboarding.

Follow the below steps to register tenant specific CWP enterprise application in the Azure

portal:

1. Access the Azure portal using the following URL https://portal.azure.com/ and, use

required tenant credentials to login into the Azure portal.

2. Post login, click the View button.

3. Click the App registrations on the left-side menu.

4. Click the New Registration button and provide the required information to register

tenant specific CWP enterprise application.

a. Name (Name of the CWP enterprise application).

. Supported account types (It is self-explanatory. Select it based on the client’s

requirement. For now, go with a single tenant).

. Redirect URI (Mention here the Tenant Specific URL that the user must be

redirected to post successful login with Azure IDP).

. Click the Register button.
. For mRounds 1.0 product the redirect URI should be added as a Single page

application.

. For iMaintenanace Product the redirect URI should be added as Web based

application.

Note:
> The CWP application URL follows the format:
<customername><tenanttype>.innovapptive.com.

For example, if the customer name is Google, the URLs will be:

= Dev: googledev.innovapptive.com
= QA: googleqa.innovapptive.com
= Prod: google.innovapptive.com
> Both QA and Prod environments share the same domain format.

iMaintenance Configuration Guide
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5. Click the Authentication on the left-side menu to select the token authorization

endpoint flow.

6. Select Access tokens checkbox and click the Save button.

7. Click the APl Permissions from the left-side menu.

a. Click the Add a permission button. You must see Request API Permissions on the

right side.

b. Click the Microsoft Graph.
c. Click the Delegated permissions.

d. Search and select email, offline _access, openid, chat, apple maps, and profile

permissions one by one.

e. Click the Add permissions button.

f. Click the Grant admin consent button.

5 0Q

. Select Microsoft APIs and click on Microsoft Graph (Refer Below)

. Add 7 user delegation permissions and 1 application permission (Refer below)

Optional: sharepoint permissions need to be added if we want to integrate

sharepoint.
(g N
Note:
In Azure App Registrations, there are two types of APl permissions:
Delegated and Application. Delegated permissions are used when
an app acts on behalf of a signed-in user, meaning the app’s access
is limited to the user’s permissions and requires user login. These are
ideal for interactive apps like web or mobile applications. Application
permissions, on the other hand, allow the app to run independently of a
user and access APIs with its own identity, typically used by background
services or daemons. Application permissions usually require admin
consent and provide broader access at the tenant level.
N J
Claim Value Permission Type Permission
Status
offline_access |Maintain access to data you have Dele- Default
given it access to gated
AccessRe- Read all access reviews Appli- | Default
view.Read.All cation
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Files.Read.All Read all files that user can access Dele- Sharepoint
gated

User.Read All Read all users' full profiles Dele- Default
gated

Files.Read.All Read files in all site collections Appli- | Sharepoint
cation

Sites.Read.All Read items in all site collections Dele- Sharepoint
gated

Sites.Read.All Read items in all site collections Appli- | Sharepoint
cation

Files.Read Read user files Dele- Sharepoint
gated

User.Read Sign in and read user profile Dele- Default
gated

openid Sign users in Dele- |Default
gated

profile View users' basic profile Dele- Default
gated

email View users’ email address Dele- Default
gated

i. Click on Add permissions and follow the below next process.

8. The following steps are useful in SAP OData endpoint authentication using SSO (SAML

2.0 Bearer Assertion Flow for OAuth 2.0).
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. Click the Certificates and secrets from the side menu. You must see the
Certificates and secrets screen.

. In the Client secrets tab, click the New client secret button. Provide description,
expiration days and then click the Add button.

. Copy the generated secret value using the Copy icon and save it in a text file, to
use at the time of tenant onboarding from the CWP web application. In case of
secret expiration, follow the above step to generate a new secret and update in
tenant onboarding.

. Click Expose an API from the side menu and then click the Add a scope button.
You'll be asked to set the Application ID URI for the enterprise application
registration. Accept the proposed default value by clicking the Save and
continue button.

. Provide the required details and click the Add scope button.

. Copy the created scope by using the Copy icon and save it in a text file (or)
Come back to Expose an API side menu for scope (View => App registrations =>
Application Name => Expose an API), to use at the time of tenant onboarding.

9. Click Overview from the side menu. Copy the Application (client) ID, Directory (tenant)

ID and Application ID URI of the newly registered CWP enterprise application and

save it in a text file (or) Come back to Overview side menu for client, tenant ids and

application id URI (View => App registrations => Application Name), to use at the time

of tenant onboarding.

10. If the user is not added into AAD Enterprise applications please follow the below steps

to add the user into a particular application.

a. Go to the e-application and look for the application that you created.
b. Open the application and select users / groups and add the user if he is not
added already to the application.

Note:

If the user is already added to the application, don’t follow the 9th step.

Table 4-1From CWPEnterpriseApp

Tenant ID

F8EBXXX=XXXX=XXXX~ XXX~ IOXXXXXX

Client ID

BOXXXXXXX=XXXXXX2ad = XXXXXX
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Application ID URI api:/ [50bfxxxxxxxx-42ad-XXXXxx

Client secret hyxxQ~wWXXXXXXXacObntd4xxxxxx

Scope api:/ [50xxxxxxx-42ad-xxxxx/netweavexxxx
(g ™

Note:

Above is the base format of the Azure Enterprise app details.
- J
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This section explains how to configure a Single Page Application (SPA) with Okta for
authentication and authorization. It covers the required settings in the Okta Admin Console

along with key considerations for integrating Okta with the SPA.

Prerequisites

Before starting the configuration, ensure the following:

« An active Okta Organization with administrator privileges
« Basic understanding of OpenlID Connect (OIDC) concepts

5.1. Okta Configuration for Innovapptive CBO (Web)

To configure Okta for CBO web application:

1. Log in to your Okta organization as an administrator.
2. Expand Applications on the left-side pane and select Applications.

Figure 5-1 Applications Screen

%} okta ¢ @ BB wwenssaniemo:
Dashboard w
Directory v Applications

STATUS

Ice Integrations ACTIVE

@ ® @

i
<
®

®

3. Click Create App Integration.
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Figure 5-2 Create App Integration

4 okta [ 2 @ 88 jnbeneiee «
Dashboard ~

Directory - Applications BB Cocumentation
Customizations - Create .ﬁ.nE Integration | Assign Users to App More ¥

Applications -~

STATUS . e v
@ Client 1D: Coacip593dWMCkBWsE97
API Service Integrations ACTIVE 1
INACTIVE o @
Securlty ~
Worktiow ~ @ Okta Browser Plugin
Report ~
eparts @ Okta Dashboard
Settings -
Okta Worknows
@) wonrows e
Cilent ID: Goaclovi7y2svRKXWES7
2 Workfiows CAUth
@B) wrtirma [
Client ID: OoaclovigBGOGOH|MES7

4. Select OIDC - OpenID Connect as the sign-in method.
5. Choose Single-Page Application for the Application Type.
6. Click Next.

Create a new app integration

Sign-in method

Learn More (2

Application type

7. Add name Innovapptive CBO <Environment> in the App integration name field.

(Environment — DEV/QA/PRD

8. In the Grant Types section, select the following options:
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- Authorization Code (default)
- Refresh Token (enable to allow for silent authentication)
9. Update Sign In and Sign Out URI's with tenant specific URI's.

(Innovapptive will provide the URL details)

Figure 5-3 Single Page Integration

& okta @ 8 B
Dashboara v
Directory . #1 New Single-Page App Integration
Customiz ations - General Settings
Applications - App Integration name dApp
Secudty Loga (Opt
Worktiow v
Reparts v @
Settings. v P i}
Loarn Mo :

Sign-in redirect URls Aliow wiidcard * in sign-in URI redirect

Sign-out redirect URs o hetps:Aicbo.innavapptiva.com|

10. Select the Assignments (controlled access) based on the tenant requirements.
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11. Click Save.

$% okta Q@ 88 M ~

Learn More
Dashboara v
Directory v

Trusted Origins
Gustomizations -

Base URls (Optional)
Applications -

+ Add URI

Security -
Workfiow v

Leam More ¢
Reports -
Sattings M Assignments

Confrolied access

Enable Immediate access (Rec

12. Copy and share the Client ID for tenant onboarding.

Figure 5-4 Copy Client ID

Directory ~ CBOFrontendSPA

©

Customizations - | Active ¥ & | view Logs

Applications -~
General Sign On Assignments Okta API Scopes Application Rate Limits

Applications

self s e

Client Credentials
AP| Service Integrations

Client ID :
Security - ¥ tifier I 1 f
Workflow ~ .
Reports ~ Client authentication None
Settings ~ Proof Key for Code Exchange (PKCE) Require PKCE as additional verification
General Settings Edit
APPLICATION
App integration name CBOFrontend SPA
Application type Single Page App (SPA)

5.2. Okta Configuration for Innovapptive CBO (Mobile)

To configure Okta for mobile application:
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1. Log in to your Okta organization as an administrator.
2. Click on the hamburger menu and select Application.
3. Click the Create App Integration button.
4. In the Create a new app integration window:
a. Select Sign-in Method = OIDC - OpenID Connect.

Figure 5-5 Select Sign In Method

Create a new app integration

Sign-in method © 0IDC - OpenlD Connect
Token-based OAuth 2.0 authentication for Single Sign-On (SSO)
through APl endpoints. Recommended if you intend to build a

Learn More (3

custom app integration with the Okta Sign-In Widget.

SAML 2.0
XML-based open standard for SSO. Use if the Identity Provider
for your application only supports SAML.

(O SWA - Secure Web Authentication
Okta-specific SSO method. Use if your application doesn't
support OIDC or SAML.
API Services

Interact with Okta APIs using the scoped OAuth 2.0 access

tokens for machine-to-machine authentication.

b. Select Application Type = Native Application.

Figure 5-6 Select Application Type

Interact with Okta APIs using the scoped OAuth 2.0 access
tokens for machine-to-machine authentication.

Application type Web Application

What kind of application are you trying to integrate Server-side applications where authentication and tokens are

with Okta? handled on the server (for example, Go, Java, ASP.Net, Node.js,
PHP)

Specifying an application type customizes your R .
pecilying ¥ 4 Single-Page Application
experience and provides the best configuration, R R X R
. . Single-page web applications that run in the browser where the
SDK, and sample recommendations.
client receives tokens (for example, Javascript, Angular, React,

Vue)

© Native Application
Desktop or mobile applications that run natively on a device and
redirect users to a non-HTTP callback (for example, iOS, Android,
React Native)

cancel m

c. Click Next.
d. Add name “Innovapptive CBO Mobile <Environment>” in App integration name
input.
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(Environment — DEV/QA/PRD)

e. Select Grant type,
= Authorization Code
= Refresh Token

Figure 5-7 Native App Integration Screen

00 sainikhil.dondeti@i...
%:% okta Q @ 0o n?-ngkawz:p(: vnedfma(\ B
Dashhoard v
Directory . i1 New Native App Integration

Customizations v General Settings
Applications ~ App integration name Innovapptive CBO Mabile
Security v
Logo (Optional a5
Workflow v @
Reports v
Settings v
Proof of possession Require Demonstrating Proof of Possession (DPoP) header in token

requests

Note:

No advanced properties required

f. Add msauth://com.innovapptive.mrounds/ in
Sign-in redirect URi's

Sign-out redirect URi's
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$& okta

Sign-in redirect URIs

Learn More (5

Sign-out redirect URIs (Optional)

Learn More [

@ &

Allow wildcard * in sign-in URI redirect.

msauth://com.innovapptive.mrounds/| X
+ Add URI
msauth://com.innovapptive.mrounds/ X
+ Add URI

g. Select Control access given below and select immediate access.

h. Click Save.

Figure 5-8 Select Controlled Access

= $¢ okta

Assignments

Controlled access

Enable immediate access (Recommended

® &8

© Aliow everyone in your organization to access
Limit access to selected groups
Skip group assignment for now

@ Enable immediate access with Federation Broker Mode
To ensure optimal app performance at scale, Okta End User

Dashboard and provisioning features are disabled. Learn more

about Federation Broker Mode(2

mukesh.zingare@i...
innovapptive-trial-...

mukesh.zingare@i..
innovapptive-trial-...

~

i. Navigate to the General tab.

j- Under the Client Credentials section, click edit and change the Client

Authentication to Client Secret.
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k. Uncheck the option Require PKCE as additional verification and click Save.

Figure 5-9 Select Values in General Tab

Dashboard v Innovapptive CBO Mobile

©

Directory ~ { Active ¥ { A ‘ View Logs
Customizations v
General Sign On Assignments Okta APl Scopes Application Rate Limits
Applications ~
Applications
) Client Credentials Cancel
Self Service

Client ID OoakrgmoabZDb5L9e697
Public identifier for the client that is required for all

API Service Integrations

Security v OAuth flows.
Workflow v Client authentication None
© Client secret
Reports ~ Public key / Private key
Settings v Proof Key for Code Exchange (PKCE) Require PKCE as additional verification

1. A new client secret is generated.
Share Secret securely with Innovapptive for tenant configuration.

Figure 5-10 Share Secret

$& okta [a 83

Client ID OoakrgmoabZDb5L9e697 B |

Dashboard hd

Directory e Public identifier for the client that is required for all
OAuth flows.
Customizations v
e Client authentication None
Applications o
Client secret
Applications Public key / Private key
Self Service Proof Key for Code Exchange (PKCE) Require PKCE as additional verification

API Service Integrations

Security ~ CLIENT SECRETS
Workflow ~ -
Generate new secret
Reports ~
Creation date Secret Status
Settings hd
OCt 30, 2024  essesssscsscasssssssnssasssssssssssnnnsnnes ©o B
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5.3. Tenant Onboarding Details and Field Mapping

This section outlines the information required for tenant onboarding and how Okta
configuration fields map to Innovapptive CBO tenant fields.

Details Required for Tenant Onboarding

The following details must be provided to Innovapptive to complete tenant onboarding:

ClientID 0O AXXXXXXXXXXXXXX97

Audience api://node.access

Issuer URI https:/ [xxx-xxxxx.okta.com/oauth2/auxxxxxxxxxxxxx

TenantID XXXXXXX

Client secret | xxx_ exXxXXT=XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX =X

Tenant Onboarding Field Mapping

The table below shows the mapping between Okta configuration fields and Innovapptive CBO
tenant fields:

Okta Configuration Field CBO Tenant Field
Tenant ID Tenant ID

Client ID Client ID

Issuer URI Authority URL

Audience Audience (Protected Resource)
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6. Authentication Identity Configuration

This chapter explains how Innovapptive’s mobile applications (such as mWorkOrder,
mRounds, and mTag) handle user authentication in a multi-tenant deployment environment.
The authentication framework is based on federated Single Sign-On (SSO) and secure token-
based session management.

It covers how users authenticate using enterprise-managed identity providers (such as
Azure AD, Google, or Okto), how access and refresh tokens are managed, and how user
data is synchronized with backend systems. This information is relevant for developers,
implementers, and security teams configuring the authentication layer in customer
deployments.

Component Overview

The authentication flow involves multiple systems working together to validate user identity,
issue secure tokens, and enable access to backend services. The table below summarizes the

core components involved:

Component Description

Innovapptive DB Stores tenant-specific configuration such as
Tenant ID, SSO method (e.g., Azure, Google),
Client ID, and Client Secret.

Tenant ID A unique identifier assigned to each cus-
tomer environment.

SSO Method Specifies the identity provider (e.g., Cogni-
to, Azure AD, Google, Okto) used for user au-

thentication.

Client ID & Secret Credentials associated with the Innovapp-
tive application registered in the tenant's SSO
provider.

Mobile App The application being used — such as m-
WorkOrder, mRounds, or mTag — initiates the
authentication request.
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Component Description

Auth Server Innovapptive’s authentication microservice,
deployed in the tenant's cloud, is responsible
for token issuance and user validation.

Users Table Managed by the Auth Server. Stores user
records, including internal User ID, SSO iden-
tifier, and SSO-issued refresh tokens.

SSO Server The tenant-managed identity provider is re-
sponsible for authenticating users and issu-
ing authorization codes and refresh tokens.

Mongo User Directory MongoDB Realm directory is used to autho-
rize users for offline data sync and database
access.

6.1. Federated SSO Login Flow

Innovapptive’s mobile apps authenticate users using federated SSO, integrating with tenant-
managed identity providers like Azure AD, Google, or Okta.

The following flow explains the complete authentication sequence—from mobile app launch
to user provisioning—highlighting how the app, backend services, SSO server, and user
management databases interact at each step.

1. The mobile app fetches the SSO method and Client ID for the tenant from the
Innovapptive DB.
2. Based on the SSO type, the app displays a single sign-in button, such as Sign in with
Google or Sign in with Okta.
3. When the user taps the button, an in-app browser opens and redirects them to the SSO
login or consent screen.
4. Upon successful authentication, the SSO server redirects the user to Innovapptive’s
landing URL with a one-time authorization code.
5. The app sends this code—along with the tenant ID—to the Auth Backend.
6. The backend sends a grant request to the SSO server using:
o Authorization code
o Client ID
o Client Secret
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7. The SSO server responds with an access token and a refresh token.
8. Using the access token, the Auth Backend fetches the user’s profile details from the SSO
server.
9. The backend then:
o Stores the user details and SSO refresh token in the Users Table
> Creates a Mongo Realm user with a unique password

10. The backend returns the following credentials to the mobile app:
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> Realm username and password
> Basic Auth JWT token (used for secure API and DB sync)

Figure 6-1Federated SSO Login Flow — From Mobile App to SSO and
Backend Sync

Figure 6-2 Authentication Module Flow V1 — Step-by-Step Message
Exchange Across Components

Backend SSO Server Backend

Mobile App Authentication User Service

Fetches Client ID of Tenant——

|——Returns with Login URL——|

Redirects User to 550 .
Congent / Login Screen

< Returns with One Time
Authorization Code

Sends the Code + Tenant ID—’

Sends Grant Request with
— Code + Client ID +
Client Secret

Returns with Access and

4 Refresh Token

Calls User Profile APl
— _’

with Access Token

Returns with User Profile
Details and 550 Refresh
Token in $50 Server

Saves User Details +

550 Refresh Token in———»|

Mongo User Directory

[——— Returns User Details

‘ Returns with Basic Auth
JWT and Realm Credentials

Reference: https://excalidraw.com/#json=Uc84zojdzuFrFQB_0mr-5,UHk6¢cX3C _yJpW-
dDgC4nPw
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6.2. Token-Based App API Flow

After the user is authenticated via SSO, the mobile app uses access and refresh tokens issued
by the Auth Server to interact securely with backend services. This section explains how these

tokens are generated, validated, and refreshed across service calls.

This flow assumes that the mobile app interacts with one or more backend services behind a

common authentication layer.

What Happens at Login

1. Once the user logs in, the Auth Server generates both an access token and a refresh
token, which are stored in the Users Table and also sent to the mobile app.
2. Both tokens are formatted as JWTs (JSON Web Tokens).
3. The access token is short-lived (default: 15 minutes, configurable).
4. The refresh token has a longer lifespan (default: 30 days, configurable).
5. Tokens are signed using asymmetric encryption:
> The Auth Server holds the Private Key used to sign tokens.

o All other backend services use the Public Key to verify access tokens.

6.3. Use the Token After Login

1. Every backend service is protected by a common middleware that validates the
incoming access token using the Public Key.
2. For user-related data:
° Services may perform read-only access to the Users Table directly for
performance.
o Alternatively, they can proxy the request via the Auth Server if direct access is
restricted or decoupled.
3. If the access token has expired (after 15 minutes), the API call will fail with an
authentication error.
4. When this happens, the app uses the refresh token to request a new access token from
the Auth Server.
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6.4. Refresh Token Handling

1. During the refresh call, the app also submits the SSO-issued refresh token to the Auth
Server.
2. The Auth Server verifies the user’s presence and active status in the tenant’s SSO
system.
3. If valid, it issues a new access token back to the app.
4. If the user no longer exists in the SSO system or is marked inactive:
> The Auth Server deletes the corresponding user entry from the Users Table.

> The app is instructed to log the user out immediately.

Figure 6-3 Token Life-cycle and Secure APl Access Using JWTs

Access Toke
Request
Service 1 Response
f_ #GE‘ Refresh Token for
\—D Refresn
>
Access Takon + ok Retresn Toen » & sor Dot + UseriD | Name | FELE
ClientID+ ——3» — Syncs
< Request Client Secret Refresh Token il 1| Person 1 | x0000x
Mobil o ser Da
Response—— | App Server « | 2 [pemson2| xoumx
Service 2 Authentication Authentication Tenant Owned DB
Access Token (15 minutes Exp
Tok Server \ceess Token (15 minutes Expiry) Server (Managed by Innovapptive)
v o/

Service 3

6.5. Alternatives for Users Table Synchronization

If the Users Table cannot always be reliably synchronized with the tenant’s SSO server,
alternative mechanisms may be considered to maintain alignment between user records
and identity provider data.

There are two commonly adopted patterns for maintaining sync between the SSO system
and the Users Table:

Scheduled Sync Pipeline

Establish a synchronization pipeline that pulls user data from the SSO server and updates the
Users Table.
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- This can be either a manual process (e.g. initiated by admin tools) or an automated
one.

« For automated sync, the cadence (hourly, daily, etc.) must be defined based on
acceptable staleness and load tolerance.

« This method is relatively straightforward but introduces a time gap between SSO
changes and backend updates.

Event-Driven Pub/Sub Model

Adopt a publish/subscribe architecture, where the SSO server emits events (e.g., user created,
updated, deactivated) to an exposed APl endpoint on Innovapptive's side.

» These events are then used to update or delete user entries in the Users Table in near
real-time.
« This approach ensures better consistency and reacts instantly to user state changes.
« However, it depends heavily on:
> The SSO provider's eventing capabilities
o Proper initial sync to align existing records

Reference: JSON Web Tokens with Public Key Signatures — Miguel Grinberg
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/. Manage Users & Roles

The User Management module allows administrators to onboard users, define roles, manage
access levels, and organize users into groups. It ensures users only see and interact with
modules relevant to their responsibilities.

This chapter has the following topics:

» Add and Modify Users (on page 44)
- Create Roles and Permissions (on page 47)

* Manage User Groups (on page 46)

7.1. Add and Modify Users

Administrators can create users manually or in bulk, assign them roles, link them to plants,
and control their access period.

To create a user manually:

1. Navigate to User Management > Active Users.

Figure 7-1 Active Users

Active Users Z INNOVAPPTIVE
User Management > Active Users

L Active Users 536 e Q oy = Add User n

O

23

O User 1L Role 1! s User Groups Email Valid Through Plant Plannin  Actions
%
3 ;
O Sahil Kumar Dev View - sahil. kumar@innovapptive.com Nov 11,2025 1000 -
L] O Nagarjuna Kola Supervisor -~ nagarjuna.kola@innovapptive.com Nov 11,2025 1000
o
o [  saiVarshakatikara Supervisor - saivarshakatikara@innovapptive.com Nov 11,2025 1000 -
* ] Prashant katiyar Supervisor - prashant katiyar@innovapptive.com Jul 11,2027 1000
-
& O Karan S Supervisor - karan.singare@innovapptive.com Nov 9, 2025 1000 1000
3 Sandeep Jh s 0 deep jh Nov 5,2025 1000
K O Supervisol - sandeep jha@innovapptive.com ov 5,
D O NA - - sundeep.ankisetty@innovapptive.com Dec 31,9999
o O NA - - vamsi.venkannagari@innovapptive.com Dec 31,9999
O Lokesh Cheede Technician - lokesh.cheede@innovapptive.com Nov 4,2025 1000

2. Click Add User > Create Manually.
3. In the Add User window, fill in the following fields:
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- First/Last Name, Title, Email

> Role, Validity Dates

o Plant, Planning Plant, Maintenance Plant
> Work Center, Reporting To, Reportees

> User Group, Data Entry Profile, Shift

Figure 7-2 Add User

Add User X
&
Upload
First Name * Last Name *
Tony Mark
Tite *
Supervisor

Email *
tony.mark@abc.com

Roles *

Supervisor M
Valid From * Valid Through *

Jun 12,2025 EI Nov 12, 2025 EI
Plant * Planning Plant

1000 v 1000 v
Maintenance Plant

annn w | A e Pt -

Cancel Add User

4. Click Add User.
The user will appear under the Active Users tab.
Use Upload Excel for bulk creation.
Download the user list via More icon > Download Users List.

To modify or deactivate a user:
> Click More icon > Edit to update details.
> Click Deactivate to disable access. Deactivated users are listed under Inactive

Users.

iMaintenance Configuration Guide 45



| 7 - Manage Users & Roles

7.2. Manage User Groups

User Groups simplify access control by grouping users with similar responsibilities. This allows
admins to assign permissions at the group level instead of individually.

To create a user group:

1. Navigate to User Management > User Groups.

Figure 7-3 User Groups Screen

User Groups
User Management > User Groups

&

Z INNOVAPPTIVE

Plant

Type
m B v v
1000 - Hamburg All 2 User Groups [ASGIVERCIGNT]

B
Q search UG 02 Modify User List
3
» UG 02 2 e O User 1L Role 1L Plant Email Actions
B User Group1 3B e O Katherine Pierce Supervisor Hamburg katherine@yopmail.com

3
O

Aaliyah Ortiz JM-tech Hamburg rashad-schulist@innovapptive.com

o s

X

4

2. Click Add User Group.

3. In the Create User Group window, fill in the following details:
> Name, Description, Plant
o Type: Planner Group or Maintenance Group

4. Click Save & Next.

Figure 7-4 Create User Group

Tyoe

Plant
1000 - Hamburg AR - 2 User Groups VXTSI
Q Search. UG 02 Modify User List

Create User Group X
UG 02 2 e D Us lant Email Actions
Name
User Group1 D) --- ) K Operations lamburg katherine@yopmail.com
0 40 CF
(] A Deseron famburg rashad-schulist@innovapptive.com
Operations
P
1000 - Hamburg -

Ty
Maintenance Group

Cancel Save & Next
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5. In the Select User window, select users and click Create.

Figure 7-5 Select Users

X
<  Select User 50 Q_ Search by Use =
User 1L Role 1L Email
O Sahil Kumar Dev View sahil. kumar@innovapptive.com
Nagarjuna Kola Supervisor nagarjuna.kola@innovapptive.com
|:| sai Varsha Katikara Supervisor saivarsha katikara@innovapptive.com
|:| Prashant katiyar Supervisor prashant.katiyar@innovapptive.com
(] Karan S Supervisor karan.singare@innovapptive.com
Sandeep Jh Supervisor sandeep.jha@innovapptive.com
|:| Lokesh Cheede Technician lokesh.cheede@innovapptive.com
|:| Bhumika Trivedi Supervisor bhumika.trivedi@innovapptive.com
O Abhishek Parkala Supervisor abhishek.parkala@innovapptive.com

To modify user groups:
- Use More icon > Edit, Copy, or Delete.
> To change members:
= Select the group > click Modify User List.
» Deselect or remove users as needed.

7.3. Create Roles and Permissions

Roles determine which modules and features a user can access. Each role can be assigned
specific permissions for either CWP 2.0 or iMaintenance.

To create a role and assign permissions:
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1. Navigate to User Management > Roles and Permissions.

Figure 7-6 Roles and Permissions Screen

2 Roles & Permissions
=

Z INNOVAPPTIVE
User Management > Roles & Permissions

fnd Roles & Permissions wee 18 Add Role

Super Admin Super Admin Save cwp2 mWorkorder

X

Q

Dashboard 110f11

(I

Super Admin
Reports 60f6

Y
B

[J supervisor

My Dashboard 5ofs v

R2

[J Technician

o

[] IM-tech EAETED) oo User Management 150f15

O A 94094 eee Active Users 50f5 v

X

[J Internal Education Director 940f9a oo Roles & Permissions 50f5 v

[ interal Education Director Copy (1)-Edit-Edit

¢

UserGroup 4ofa v

[J Advertising Orchestrator
Inactive Users 1of 1 v

[ Advertising Orchestrator Copy (1)-Edit-Edit

. Click Add Role.

. Fill in Role Name and Role Description.
. Click Save.

. Select the new role.

. Choose the modules that are required for the role or persona on the right-side.

9 N L A W

. Click save.
Use More icon > Copy to clone existing roles.

Use More icon > Delete to delete the role.

(g N
Note:
> You cannot edit or delete the Super Admin role. You can only copy.
> You cannot delete the role that is already assigned to the user. First, un-
assign the user and delete the role.
> You cannot delete roles that are assigned to users or edit the Super Admin
role.
= When a user is assigned to a module in the CWP (e.g., the Dashboard
module) and given permission to execute work orders in mWorkOrder,
they can only access the Dashboard module and perform work order
execution in the mobile app. This setup grants the user access to both the

web and mobile applications.
- J
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7.4. Bulk Upload Users

Administrators can streamline user creation by uploading multiple user records at once using
an Excel template. This method is ideal for onboarding large teams efficiently.

Note:

The Work Center field is optional during bulk user creation.

To bulk upload users:

1. Expand the User Management and select Active Users.

2. Click the More icon on the top right corner and select Download Template.
3. Fill out the Excel sheet.

4. Click Add User > Upload Excel.

5. Select and upload the file.
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8. Maintain Master Data

The Master Data module holds the foundational elements of your system—plants, locations,

shifts, assets, units of measurement, and response sets. Proper configuration ensures

consistency across forms, workflows, and analytics.

This chapter has the following topics:

 Create a Plant (on page 50)

- Create a Shift (on page 51)

- Create a Location (on page 52)

» Create an Asset (on page 53)

» Create UOM (on page 54)

» Create a Global Response Set (on page 55)

* Bulk Upload Master Data (on page 56)
8.1. Create a Plant
To create a plant:

1. Navigate to Master Data > Plants.

Figure 8-1Plants Screen

A Plants
~ Master Data > Plants
m
Plants
2
Name PlantId 1! Type 11 Country 1t Plant Timezone 1!
N
A
ol mnovapptive 234 Planning India UTC +05:30
ol mnovapptive 234 Plant India UTC +05:30
P
. gl Hamburg 1000 Planning
= m‘ Hamburg 1000 Maintenance
A Eﬁl Hamburg 1000 Plant
B ol st Petersburg Florida 3000 Planning
ol st petersburg Fiorida 3000 Plant
m‘ St. Petersburg Florida 3000 Maintenance

Q s

State L

Andhra Pradesh

Andhra Pradesh

Language TL

Spanish (Argentine)

Spanish (Argentine)

2. Click Create New.
3. In the Create Plant window, fill in the following fields:
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> Name, Plant ID, Plant Type, Country, Zip Code, State, Time Zone, and Shifts.
- Enable Shift Handover Report toggle if needed.

Note:

If the Plant ID already exists, an error message “Plant ID <> already exists”

is displayed. Use another ID.

4. Under the Additional Details section, add custom Labels & Fields.
5. Click Create.

Figure 8-2 Create Plant

Plants X

Master Data > Plants

| Create Plant

Plants Name+

Boiler Plant
Name Plantld 11 Type 11 Country 11 Plant Timezone 1L prantid

BP309
ml Innovapptive 234 Planning India UTC +05:30

Select Plant Iype

Maintenance

Innovapptive 234 Plant India UTC +05:30
Italy e
Eﬂl Hamburg 1000 Planning . .
Zip Code *
m‘ Hamburg 1000 Maintenance . . 988298
m‘ Hamburg 1000 Plant - - Alessandria hd
Select 1 anguage *
M St. Petershurg Florida 3000 Planning - - English (UK) -
Time Zone*
@l St. Petersburg Florida 3000 Plant . .
Curope/Rome (UTC +02:00) M
gall st petersburg Florida 3000 Maintenance - - Cancel ] m

Use More icon to Copy, Edit, or Delete.

8.2. Create a Shift

To create a shift:
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1. Navigate to Master Data > Shifts.

2. Click Create New.

3. In the Create Shift window, fill in the following details:
> Name, Plant, Start Time, End Time.
> Set Active toggle to make the shift active.

4. Click Create.

Figure 8-3 Create Shift
Shifts x

Create Shift

Shifts sme
Morning Shift

Shift Name Start & End Time

Noon Shift 12:00 - 18:00 00:30

Active

Cancel

8.3. Create a Location

To create a location:
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1. Navigate to Master Data > Locations.
2. Click Create New > Create Manually.

3. In the Create Location window, fill in the details, such as Name, Location ID, Model,

Description, Plant, and Parent.
4. Click Create.

Figure 8-4 Create Location

Locations
Master Data > Locations

Plant

1000 - Hamburg e

D1 Name T Description T

18}, 1111-222-AB-33 Inspection zone- AB-33 Inspection zone- AB-33

Flevator Goods Fntrance 2, Flevator Goods Fntrance 2,

% Rre0z-01-00/02 Building 1 Building 1

% kars2 -

% kiBR2:32 Flltration plant - iiter 2 Flltration plant - filter 2

FUSESEY Mechanical purification Mechanical purification
2nd biolog. cleaning - 2nd biolog. cleaning -

& wrerza meaouing plant meacurng slant

9 K1-BR2-21 Intermediate plant - flushing Intermediate plant - flushing

L\ pump 1 pump 1

% kimer Mechanical purification Mechanical purification

8.4. Create an Asset

To create an asset:
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X

. Create Location

139035 Log

Blologh

2nd big
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2nd big

2nd big
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%

Wing2

LocationId *

Locw22

Model

Mod1

Description

Plant

1000 - Hamburg

Pare

Grit chamber - tank 2 - K1-MER-12

Cancel
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1. Navigate to Master Data > Assets.

2. Click Create New > Create Manually.

3. In the Create Assets screen, fill in the fields, such as Name, Asset ID, Model, Description,

Plant, Parent Type/Name.
4. Click Create.

Figure 8-5 Create Asset

Assets
Master Data > Assets

Plant

1000 Hamburg

D1
s 10257176
e 10257175
e 10257174

e 10257173

Sy 10257172

e 10257171

e 10257170

. anos71R0

Name 1L

Excavator-01

Conductors pump

Conductors

Pump bearing 15/5

COMPRESSOR PLANT-1000

TRACE EDT-123

EDT DEVICE AB-2

ERT REVIAE ARCT

8.b. Create UOM

To create a UOM:

Description TL

Excavator-01

Conductors pump

Conductors

Pump bearing 15/5

COMPRESSOR PLANT-1000

TRACE EDT-123

FDT DFVICF AB-?

ENT REVIFE AR
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168282 / %

L=

Model 1L Parent fane
Roiler Machine

5000 T Assetld
AS739821
Pumpf
- q Model
| AS230821
PUMDS
- 98
Description:
Piant s
10 Comprt
- o 1000 - Hamburg
hrx-10 EDIDE  parentType (O Location
16
1 Paren
EDTDE
- 18
Cancel

100 -

@ Asset
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1. Navigate to Master Data > Unit of Measurement.
2. Click Create New > Create Manually.
3. In the Create Unit window, fill in the following fields:
> Measurement Type, Description, Symbol.
> Add more entries as needed.
4. Click Create.

Figure 8-6 Create UOM

Master Data X

MasterData > Unit of Measurement ot Messurement -

Degree
UoM [object Object] Q Froduct®
mWorkorder v
Unit of Measure Product noofUnits units SYMBOl  pegeription Symbol
Description symb
1 Megawatt hours MWH Degree °
1 Troy Ounce ozt Kelvin K
1 Millivolt MV * Ada More
1 Nanosecond NS
1 Melric ton Bitumen MTB
1 Newlon/Meler NM
1 Metricton mMT
Cubic millimeter MM3
Millitesla MTE

o Cancel Create

8.6. Create a Global Response Set

To create a global response set:
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1. Go to Master Data > Global Response Set.

2. Click Create New > Create Manually.

3. In the Create Global Response Set window, fill in the following fields:
> Name, Description, and Metadata Type.
> Add response values.

4. Click save.

Figure 8-7 Create Global Response Set

Global Response X

Master Data > Global Response Set

Create Global Response Set

Global Response Set
Condition Logic

Title Responses Created By

All 1
All 1
All 1
Al 1
Al 1
Al 1
Al 1
Al 1

Cylinder Condition 5

Cylinder Condition 5 __ —_—

8.7. Bulk Upload Master Data

Bulk upload reduces manual effort for setting up master data.

To bulk upload master data:

1. Navigate to the respective module (Loccltions, Assets, UOM, or Response Sets).
2. Click the More icon on top right corner and select Download Template.

3. Fill out the Excel sheet.

4. Click Create New > Upload Excel.

5. Select and upload your file.
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9. Configure iMaintenance Core Settings

The Core Settings in iMaintenance define how the product behaves across your entire
organization. These settings control fundamental aspects of daily use, such as session
timeouts, chat availability, measuring points, auto-timers, Al enablement, issue creation, root
cause analysis, attachments, and more.

Although many of these options are stored at the database level, they directly influence how
technicians, supervisors, and administrators experience the product every day. Functional
teams should review these configurations to ensure they align with business processes, while
IT teams may assist in applying the changes.

By configuring these core settings, you can tailor iMaintenance to match your organization’s
operational needs, improve usability, and enforce consistent standards across all users.

- )
Note:
To modify the configurations, use the below collection in the database. Tap on the
collection to view the list of configurations, each identified by its respective "type".

Collection Name: Configuration
N J

9.1. Enable or Disable Core Modules

The Issue, Work Order, and Timesheet modules can be enabled or disabled at both the
tenant and plant levels. These settings determine whether the modules are visible and

accessible across the web and mobile applications.

« Use the tenantLevel flag to turn a module on or off globally for all plants.

« Use the plantLevel flag for more granular control, enabling or disabling modules for

individual plants.
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1. Issue, Work Order, Timesheet Configurations
> The Issue, Work Order, Timesheet module Configuration controls the visibility
and accessibility of the Issue, Work Order, Timesheet modules across the Tenant or
Plant levels within your deployment. Use the following flags to manage access
appropriately based on organizational needs.
2. tenantLevel Flag
> Purpose: Controls module access at the Tenant level.
- Options:
= true: Enables the Issue Module for all plants under the tenant.
= false: Disables the Issue Module globally across all plants.
= Default Value: true
o Set as true if you want all plants to access the Issue Module.
o Set as false to completely disable the Issue Module across the tenant.
3. plantLevel Flag
o Purpose: Enables fine-grained control at the Plant level.
- Options:
- false: Module access is the same across all plants (as per tenantLevel
setting).
= true: Enables plant-specific control. You must provide a valid plant ID for
each plant you want to configure.
= Default Value: false
> Set to true if you want to enable/disable the module per plant.

o Set to false if plant-level configuration is not required.

Sanpl e Configuration
{
toidtr {
"$oi d": "6811d64el0Ochda7d4d979883"

b

"type": "issueConfig", //Type would change for WrkOrder and Ti nesheet nodul es
“config": {
"tenant Level ": true,
"plantLevel ": true
h
"plant": {

"$oi d": "68la06b3aab43f 5e132f f 5¢3"
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e N

Note:

« When a module is disabled, both their creation and any related features will be
hidden and inaccessible across the Mobile and Web applications.

« Ensure consistency between tenantLevel and plantLevel flags to avoid
misconfiguration.

- If plantLevel is set to true, you must maintain a corresponding configuration for

each relevant plant.

- J

9.2. Configure Work Order Settings

Work Order settings define how iMaintenance enforces controls during the lifecycle of a Work

Order — from initiation to completion.

These configurations allow you to:

« Configure Measuring Points

« Automate timing of work execution.

« Trigger issues directly from forms.

« Capture follow-up issues.

« Confirm operations before closure.

- Record and analyze Root Cause Analysis (RCA).

Use these sub-settings to align Work Order execution with your organization’s compliance,

safety, and operational standards.

Configure Measuring Points

The Measuring Point (MP) Configuration manages the visibility and availability of measuring
points across key modules within the system. Admins can control this setting at both the

Tenant and Plant levels, based on operational requirements.

+ Enable or disable measuring point features across all or selected modules. Supports
module-level visibility for: Functional Location, Equipment, Issue, Asset, Asset360, Work
Order, Work Order Operation.

« Configuration is stored in the database and applied per tenant or plant.
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Table 9-1Default Settings

Setting Default Val- | Description

ue
tenantLevel TRUE Measuring Point is available across all plants by de-

fault.

plantLevel TRUE Enables plant-specific control of MP visibility.
functionalLocation | TRUE Measuring Point visible in Functional Location module.
workOrder TRUE Measuring Point visible in Work Order module.
workOrderOpera- | TRUE Measuring Point visible in Work Order Operation.
tion
issue TRUE Measuring Point visible in Issue module.
asset TRUE Measuring Point visible in Asset module.
asset360 TRUE Measuring Point visible in Asset360 view.
realmsync TRUE Measuring Point included in realm sync processes.

Sample Configuration

{

tidt

"$oi d": "67fdf f ef 33f 2f 7a34586f bf 3"

}

"type": "nmeasuringPoi nt Config",

“config": {

"tenant Level ": true,

“functional Locati on":

“workOrder": true,

"wor kOr der Cper ati on":

"issue": true,
"asset": true,
"asset 360": true,
“real nBync": true,

“pl ant Level ": true

"plant": {

true,

true,

iMaintenance Configuration Guide

60



| 9 - Configure iMaintenance Core Settings

"$oi d": "68la06b3aab43f 5e132f f 5¢3"

}

. )

Note:

« By default, Measuring Points are enabled across all modules and all plants.

« Use tenantLevel = false and plantLevel = true to apply visibility settings for
specific plants.

« All module-level flags (functionallLocation, workOrder, etc.) must be explicitly set
to true or false depending on business needs.

« Disabling a module flag will hide measuring points from that specific module

across the Web and Mobile applications.

- J

Configure Auto Timer

The Auto Timer Configuration controls whether an automatic timer is enabled for Operations
during Work Order execution. This setting can be managed at both the Tenant and Plant
levels to align with organizational workflow preferences.

Admins can control the behavior of the Auto Timer feature using the following configuration
options:

- Enable/Disable Auto Timer
« Allow Technician to Edit Timer
+ Enable Background Time Calculation

Table 9-2 Default Settings

Setting Default Val- | Description
ue
enabled TRUE Enables the Auto Timer by default.
editable TRUE Allows the Technician to edit the timer manually.
back- TRUE Timer is auto-calculated in the background without user inter-
ground action.

Sample Configuration
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"$oi d": "6788b584c3ca9a2f 538dbc19"

"type": "autoTiner",
"plant": {

"$oi d": "68la06b3aab43f5e132ff5c3"

“config": {
"enabl ed": true,
"background”: true,

"editable": true

e N

Note:

- If enabled is set to false, the Auto Timer feature is disabled entirely for that
tenant or plant.

- If editable is false, the Technician will not be allowed to adjust the timer
manually during execution.

- If the background is false, time tracking will require manual start/stop by the
Technician.

- J

Configure Raise Issue at Form Submission level

The Raise Issue Configuration controls whether an Issue can be raised automatically when a
Digital Form is submitted. This setting is configurable at both the Tenant and Plant levels to

support enterprise-specific workflows.

- Enables or disables the triggering of issues from form submissions.
« Supports use cases where form-based inspections or checklists can result in
actionable issue records.
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Table 9-3 Default Settings

Setting |Default Val- | Description
ue
formLev- | FALSE When false, the system will allow raising issues from form submis-
el sion.
Sample Configuration

{
tid"r {
"$oi d": "6821e6077218a319b2e8bb88"

h

"type": "raiselssue",

“config": {
"fornLevel ": false

b

“plant”: {

"$o0i d": "68la06b3aab43f 5e132ff 5¢3"

}

e N

Note:

+ When formLevel is set to false, issue creation will be triggered automatically
upon digital form submission.

« If formLevel is set to true, the raise issue option will be suppressed on form
submission screens.

« This setting is useful for controlling noise or limiting automated issue creation in
certain workflows or plant environments.

- J

Configure Raise Follow-up Issue

The Raise Follow-up Issue Configuration defines how follow-up issues are handled when
linked to a Work Order. This setting is applicable at the Tenant Level and helps streamline

corrective workflows after execution tasks.
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- Enables or disables the ability to raise follow-up issues from within a Work Order.

« Admins can configure how the follow-up issue behaves:

° independentissue — Creates a new, standalone issue with no linkage to the

original work order.

o linkToWorkOrder — Automatically links the follow-up issue to the originating work

order.

o linkAndDelinkToWorkOrder — Auto-links the issue to the work order but gives

Supervisors the option to delink if needed.

Table 9-4 Default Settings

Setting Default Description
Value
tenantLevel TRUE Applies configuration across all plants under the tenant.

raiseFollowUplssue TRUE

Enables the follow-up issue creation capability.

independentlssue FALSE

Follow-up is not created as standalone by default.

linkToWorkOrder FALSE Follow-up is not auto-linked only.
linkAndDelinkTo- TRUE Follow-up is auto-linked, with an option to delink (de-
WorkOrder fault behavior).

Sample Configuration

{
tid"r {
"$oi d": "682495bc6f 10a452d982a052"
I

"type": "raiseFol | owpl ssueConfig",

“config": {
"tenant Level ": true,
“rai seFol | owUpl ssue": true,

"i ndependent | ssue": fal se,
"linkToWwor kOrder”: false,

"1 i nkAndDel i nkToWor kOrder": true
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e N

Note:

« This setting only applies at the tenant level; plant-level overrides are not
supported at this time.

« Ensure that only one mode is set to true at a time to avoid conflicting behaviors.

« If raiseFollowUplssue is set to false, no follow-up issue options will be presented
during or after Work Order execution.

« The linkAndDelinkToWorkOrder mode offers flexibility and is recommmended for
most operational scenarios.

- J

Configure Operation Confirmation

The Operation Confirmation Configuration controls whether operation-level confirmations
are enabled during Work Order execution. This configuration can be managed at both the
Tenant and Plant levels to suit specific operational or compliance requirements.

- Allows enabling or disabling operation confirmations (e.g., start/complete or quantity
confirmations) for each operation step within a Work Order.

« Useful in industries where granular tracking of operation progress is required for
compliance, audits, or productivity metrics.

Table 9-5 Default Settings

Setting Default Val- | Description

ue
tenantLev- | FALSE Operation confirmation is not enabled at the tenant level by de-
el fault
plantLevel |FALSE Operation confirmation is not enabled at any plant level by de-

fault

Sample Configuration
{
tidt
"$oi d": "6847e24eb8edacc8be69cf 93"

b

"type": "operationConfirmationConfig",
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"config": {
"tenant Level ": fal se,
“pl ant Level ": fal se

b
“"createdAt": {
"$date": "2025-05-28T12: 45: 00. 000Z"
b
"updat edAt": {

"$date": "2025-05-28T12: 45: 00. 000Z"

}

e N

Note:

« If both tenantLevel and plantLevel are set to false, operation confirmations will
be hidden from the Ul and not required during Work Order execution.

« Enabling confirmation at plantLevel requires specifying the plant context in the
configuration document.

« Use this feature to enforce process discipline and track execution detail at a

more granular level.

- J

Configure Work Order RCA

The Work Order RCA (Root Cause Analysis) Configuration defines whether RCA tracking is
enabled at both the Work Order and Work Order Operation levels. This configuration allows
organizations to enforce structured problem analysis during or after maintenance execution

at either the Tenant or Plant level.

« Enables Root Cause Analysis feature as part of the Work Order lifecycle.
« Configurable at:

> Tenant Level — Applies across all plants.

> Plant Level — Allows plant-specific overrides (if supported in implementation).
« RCA visibility and workflow can be toggled for:

o workOrderLevel — RCA enabled at the overall Work Order level.

- workOrderOperationLevel - RCA enabled for each individual operation/task.
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Table 9-6 Default Settings

Setting Default Value | Description

tenantLevel TRUE RCA settings apply across all plants by default.
workOrderLevel TRUE RCA is enabled at the Work Order level.
workOrderOperationLevel | TRUE RCA is enabled for each Work Order operation.

Sample Configuration

{
@ f@Py g
"$oid": "6846cebdef b99e538f a46336"
e

"type": "workOrder RCAConfig",

"config": {
"tenant Level ": true,
"wor kOr der Level ": true,
“wor kOr der Oper ati onLevel ": true
}
}
g N

Note:

« If workOrderLevel is false, RCA will not be visible or required at the Work Order
header level.

« If workOrderOperationLevel is false, RCA will be hidden from individual operation
steps.

- Enabling both levels provides full visibility into root causes at both macro (order)
and micro (operation) levels—ideal for high-compliance or reliability-focused
environments.

* These settings are useful for supporting failure analysis, audit trails, and

continuous improvement initiatives.

- J

9.3. Configure User Experience Controls

User Experience (UX) controls define how iMaintenance appears and responds to users
across both web and mobile applications.
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These settings apply at a product-wide level and influence everyday interactions — from how
long a session remains active, to whether chat and attachments are available, to how lists
and key fields are displayed.

By configuring these options, administrators can:

« Standardize how users access and share information.
« Control the visibility of supporting features such as chat and attachments.

« Enforce consistent formats and templates for lists, forms, and key mappings.

These configurations ensure a smooth, predictable user experience while aligning
iMaintenance with your organization’s compliance and collaboration needs.

Configure Session Timeout

Session timeout settings define how long a session remains active during inactivity.

« Session timeout can be configured at Tenant Level or Plant level.

« Default Session Timeout is at tenant level and set for 30 mins.

« All sessions login and logouts are captured in DB for audit purposes.

« The highlighted DB values should be used to manage Session timeout.
> Session Timeout can be Enabled or Disabled by setting True or False.
- Duration can be set in Million Seconds. Ex 30 mins/ 1800000 Ms

vidtr {

"$oi d": "6788b5dec3ca9a2f 538dbcilc”
b
"type": "sessionTi meout",
"plant": {

"$oi d": "68la06b3aab43f5e132ff5c3"
e
“config": {

"enabl ed": true,

"duration": 1800000

User is shown with a warning message when session is timed out and redirected to login
screen.
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Configure Chat Controls

The Chat Configuration controls chat functionality at both Tenant and Plant levels. It allows
administrators to enable chat for specific modules and define push notification behavior.

« Enable or disable chat features across tenants or specific plants.
« Module-specific control: Currently supports the Issue and Work Order modules.
« Push notification customization: Choose between receiving all messages or only

@mentions.

Table 9-7 Default Settings

Setting Default Val- |Description

ue
chat TRUE Enables chat feature globally.
issueModule TRUE Chat enabled for Issue Module by default.
workOrderModule TRUE Chat enabled for Work Order Module by default.
pushNotifications.all FALSE Sends notifications for all messages.
pushNotifications.men- | TRUE Sends notifications only when a user is men-
tion tioned.

Sample Json Configuration

{

" f@rs §
"$oi d": "67fcdb5efffbl552aa9ae6272"

b

“type": "chat Config"

_v": 0,

“config": {
“chat": true,
"wor kOr der Modul e": true,
"i ssueMbdul e": true,
"pushNotifications": {

"all": true,

“mention": false
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"plant": {

"$o0i d": "68la06b3aab43f 5e132f f 5¢3"

}

e N

Note:

 Configurations are persisted in the database and applied per tenant or plant as
needed.
« Admins can selectively disable chat for specific modules by setting the
respective module flag (issueModule, workOrderModule) to false.
« Push notification behavior:
> Set "all”: true to notify users on every message.
> Set "mention™: true to notify only on direct mentions (useful for reducing
noise).
« A plant entry is required when applying plant-level configurations.

. J

Configure Attachments

The Attachment Configuration manages how attachments are handled across various
modules like Issue, Work Order, Functional Location, Equipment, etc., at both the Tenant and
Plant levels. Admins can configure the available repositories, their behaviors, and permitted
document types per module.

« Define which modules support attachments (e.g., Issue, Work Order, Asset, Measuring
Point).
« Specify one or more repository types for each module:
> GOS (Generic Object Services)
- DMS (Document Management System)
= SharePoint (not shown in the current example but assumed as extensible).
- Configure actions (e.g, create, delete) and document type rules for repositories like
DMS.
« Store configuration in the database for runtime enforcement.

Table 9-8 Default Settings

Module Repositories | Default App ID
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Table 9-8 Default Settings (continued)

Issue GOS NOATT
WorkOrder GOS WOATT
Asset GOS, DMS EQATT
FunctionalLocation | GOS, DMS FLATT
MeasuringPoint GOS, DMS MPATT
MeansDoc GOS, DMS MDATT

Sample Configuration

{
° @l g
"$oi d": "6829c064cf 146098dc602988"
I
"type": "attachnents",
_v": 0,
“config": {

"lssue": {

“repositories": ["G08"],
"appld": "NOATT"

H

"Wor kOrder™: {

“repositories": ["G08"],
“appld': "WOATT"

h

"Asset": {

“repositories": ["GOS", "DWB'],
"appl d": "EQATT"

}

"Functional Location": {
“repositories": ["GOS", "DWB'],
"appld": "FLATT"

H

"MeasuringPoint": {
“repositories": ["GO8", "DWB'],

"appld": "MPATT"
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b
"MeansDoc": {
"repositories": ["GOS", "DMB'],
"appld": "MDATT"
I
eS|
“url™: "/ WORKORDER_SRV/ Product At t achnent Col | ecti on",
“actions": [“"create", "delete"]
H
"DMVB': {
“url": "/ 1 WORKORDER _SRV/ Product At t achnent Col | ecti on",

"actions": ["create"],
"docunent TypesConfig": {

“lssue": [

"docunent Type": "DES",
"docunent Versi on": "00",
"docunent Part": "000",

"storageCategory": "DMS_Cl_ST"

b

{
"docunent Type": "DRW,
"docunent Versi on": "00",
"docunent Part": "000",
"storageCategory": "DMS_Cl_ST"

}

1.

"WorkOrder™: [

{
"docunent Type": "DES",
"docunent Ver si on": "00",
"document Part": "000",
"storageCategory”: "DMS_Cl_ST"

h

{

"docunent Type": "DRW,

"docunent Ver si on": "00",
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"docunent Part": "000",

"storageCat egory”: "DMS_Cl_ST"

}
1.
"Asset": [
{
"docunent Type": "DES",
"docunent Ver si on": "00",
"document Part": "000",
"storageCat egory”: "DMS_Cl_ST"
I
{
"docunent Type": "DRW,
"docunent Ver si on": "00",
"document Part": "000",
"storageCategory”: "DMS_Cl_ST"
}
I

"Functional Location": [

{
"docunent Type": "DES",
"docunent Ver si on": "00",
“docunentPart": "000",
"storageCat egory": "DWMS_Cl_ST"
b
{
"docunent Type": "DRW,
"docunent Ver si on": "00",
“docunentPart": "000",
"storageCat egory": "DWMS_Cl_ST"
}

1.
“MeasuringPoint": [
{
"docunent Type": "DES",
"docunent Ver si on": "00"

"docunent Part": "000",
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"storageCategory": "DMS_Cl_ST"

"docunent Type": "DRW,
"docunent Versi on": "00",
"docunent Part": "000",

"storageCategory": "DMS_Cl_ST"

1.

“MeansDoc": []

b
“createdAt": {
"$date": "2025-05-18T11:11:32.183Z"
h
"updat edAt": {

"$date": "2025-06-16T14: 40: 23. 8517"

}

e N

Note:

« Repositories such as GOS and DMS must be configured with their respective url
endpoints and supported actions (e.g., create, delete).
» DMS repositories support advanced configuration with documentTypesConfig to
define rules like:
> Document Type (e.g., DES, DRW)
> Version/Part/Storage category.
« Admins should ensure that each module has a valid appld for integration
consistency.
« SharePoint configuration is assumed to be supported but not defined in this
example. It can follow a similar structure.
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Configure List View

List View Configurations define how records are displayed in the list views for different
modules (e.g., Work Orders, Issues, Equipment, Functional Locations). Each configuration
controls which Fields are visible, their labels, backend data mappings, and optional

formatting types (e.g., Date).

These configurations are managed at the database level and directly affect the user
interface layouts for Mobile apps.

Table 9-9 Common Parameters

Field Description

displayName | The label shown to the user in the column header (e.g., "Location”).

keyName The backend key to fetch data (e.g. location.name, asset.name).

type Optional — used for formatting data (e.g., "date” for date fields).

order Implicit — the JSON field order defines the column order in the UI.
Work Order List View

{

"_id": { "$oid": "6846aed763dacd6d3628dc94" },

"type": "workOrderlListTenplate",

“config": {
“fields": [
{ "displayNanme": "Location", "keyNane": "location.nane" },
{ "displayNane": "Equipnent”, "keyNane": "asset.name" },

{ "displayName": "Description", "keyName": "description" },

{ "displayName": "Planning Plant", "keyNane": "planningPl ant.erpPlantld" },

{ "displayNanme": "Mintenance Plant", "keyName": "mai ntenancePl ant.erpPlantld" },

{ "displayName": "Required Start Date", "keyNane": "plannedStartTi ne", "type": “"date" },
{ "displayNanme": "Required End Date", "keyNane": "plannedEndTi me" },

{ "displayName": "Created By", "keyNane": "createdBy.firstNane" },

{ "displayName": "Testing", "keyName": "testing" },

{ "displayNanme": "Revision", "keyName": "others.revision" },

{ "displayNanme": "Code G oup", "keyNane": "others.codeG oupld" },

{ "displayNanme": "Work Center", "keyName": "workCenter.erpWrkCenterld" },

{ "displayNanme": "Breakdown", "keyNane": "breakdown" }
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Issue List View

: "location.name" },

"asset.nane" },
"description" },

"pl anni ngPl ant. erpPl ant 1 d" },

, "keyName": "plannedStartTine", "type": "date" },

" keyNane" :

“testing"

"pl annedEndTi ne" },

“createdBy. firstName" },

h

: "others.revision" },

{
"_id": { "$oid": "6846af 3763dacd6d3628dc95" },
“type": "issuelistTenpl ate",
“config": {
"fields": [
{ "displayNanme": "Location", "keyNane"
{ "displayNanme": "Equipnent”, "keyNane":
{ "displayNanme": "Description", "keyNanme":
{ "displayName": "Planning Plant", "keyNane":
{ "displayName": "Required Start Date"
{ "displayNane": "Required End Date",
{ "displayNanme": "Created By", "keyNane":
{ "displayNanme": "Testing", "keyName":
{ "displayNanme": "Revision", "keyNane"
{ "displayNanme": "Code G oup", "keyNanme":
{ "displayName": "Work Center", "keyNane":
I
}
}

Equipment List View

"_id": { "$oid": "6846af 6d63dacd6d3628dc96" },

“type": "equi pnentListTenpl ate",
“config": {

“fields": [

{ "displayNanme": "Description", "keyNane":

{ "displayNanme": "Location", "keyNane"

"ot hers. codeG oupl d" },

"wor kCent er. er pWor kCenterld" }

“description" },

: "location.erpAssetld" },

{ "displayName": "Type", "keyNane": "type" },

{ "displayNanme": "Manufacturer Name",

{ "displayNanme": "Manufactured In", "keyNane":

{ "displayNane": "Planning Plant", "keyNane":

{ "displayNane": "Maintenance Plant",
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}

Functional Location List View:

{
"_id": { "$oid": "6846af 8a63dacd6d3628dc97" },
"type": "functional LocationLi st Tenpl ate",
"config": {
"fields": [
{ "displayNanme": "Type", "keyNane": "“type" },
{ "displayNanme": "Manufacturer Name", "keyName": "manufacturer.object.name" },
{ "displayNane": "Manufactured In", "keyNane": "manufacturer.object.country” },
{ "displayNane": "Planning Plant", "keyNane": "pl anningPl ant.erpPlantld" },
{ "displayNane": "Maintenance Plant", "keyName": "mmintenancePlant.erpPlantld" }
]
}
}
o ™
Note:
« All keyName values should map to valid fields defined in the corresponding
module’s Field Configuration.
» The order of fields in the array defines the column order in the UL
- Fields with type: "date” will be formatted as per locale/timezone rules.
* These configurations can be modified to customize user-specific or role-based
layouts (if supported).
- /
Configure Innovapptive Key Mapping
{
° @l g
"$o0i d": "6790eabOf 1f 16f 84aa3de757"
B
"type": "innovapptiveKeyNMapping",
"config": {
"breakdown_| SSUE": "M",
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"breakdown_WO': " PM3",
“corrective_l SSUE": "ML",
“corrective_WO': "PM2",
"enmergency_WO': "EMER',
“preventive_WO': "PM1",
"service_| SSUE": "S1",
"obj ect Category_EQ': "I EQ',
"obj ect Category_FL": "IFL",
"issueSystenttatus": {
"DLFL, NOCO': "Rej ected",
"OSNO': "Open",
"NOPR, ORAS": "I n-Progress",
"NOPR': "Rel eased",
“NOCO': " Conpl et ed”
H
"woOper at i onSyst ent at us": {
"CRTD': "Not Started",
"CLSD': "Conpl eted",
"REL": "Rel eased",
"PCNF": "Partial Confirnt,
"MCNF": “"Partial Confirnt,

"CNF": "Conpl et ed"

I

"issueProcessControl ": {
"1": "All owed",
"2": "WMrning",
"3": "Prohibited"

h

"wor kOr der SystenBtatus”: {
"CRTD': "Created",
"REL": "Rel eased",
"TECO': "d osed",

"CLSD': "d osed"

“plant": {
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"$oi d": "68la06b3aab43f 5e132f f 5¢3"

9.4. Configure Al

The Al Configuration controls the availability of Al-powered features at both the Tenant and
Plant levels. Admins can selectively enable or disable access to specific Al agents used
across modules like Issue Management, Work Order Planning, and Technician Assistance.

« Tenant- and Plant-level control over Al feature availability.

- Fine-grained toggles to enable/disable individual Al agents. Al agent features include:

o Al Assist — Technician assistance during task execution.
o Al Plan = Smart planning and scheduling recommendations.

o Al Detect - Fault detection and predictive diagnostics.

Table 9-10 Default Settings

Setting Default Val- | Description
ue
tenant- TRUE Al features enabled across all plants by default.
Level
QiAssist TRUE Enables the Al Assist feature.
aiPlan TRUE Enables Al-driven planning capabilities (assumed field, not in
sample).
aiDetect |TRUE Enables Al-based fault detection and diagnosis (assumed field).

Sample Configuration

{
tid"r {
"$oi d": "68065dcd91f 242c6956f 47ca”
I

“type": "aiConfig",

“config": {
“tenant Level ": true,
"ail ssue": true,
"ai WorkOrder": true,
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"ai Assist": true

}

. )

Note:

« Al configurations are stored in the database and can be customized per tenant
or plant.

- If tenantlLevel is set to false, plant-level overrides must be defined with
associated plant IDs.

« Each Al agent (aiAssist, aiPlan, aiDetect) can be individually toggled based on
usage needs and licensing.

 Ensure consistent settings across modules and levels to avoid unexpected
behavior in Al feature availability.
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10. Integrate External Systems

The Integration Manager module connects the Innovapptive platform to external ERP
systems, enabling seamless data flow between your operational tools and enterprise
backend. It supports real-time syncs, offline handling, and automated data exchanges.

Earlier, integrating operator round data with SAP PM and PI Historian demanded custom code
and weeks of work.

Now, with RACE and Integration Manager, admins link mobile round data to Pl tags and SAP
work orders using a no-code interface. Anomalies flow instantly from the field to SAP PM.

Impact, 60% faster integration, improved data consistency, and seamless automation from

shop floor to enterprise.

10.1. Understand the Integration Workflow

Integration Manager supports three types of data synchronization:

Type Description

Inbound Integration Imports master data (plants, locations, as-
sets) from ERP to the Innovapptive platform.
Usually done during tenant onboarding.

Outbound Integration Pushes transactional data (e.g., issues, work
orders) from the platform to ERP.

Delta Sync Periodically syncs offline transactions by de-
tecting and posting new/updated records
once connectivity is restored. Runs via a
scheduled cron job (every 2-4 hours).

Mobile users receive a consistent experience as master and transactional data are shared

across web and mobile.

10.2. Connect to ERP

Connecting the platform to the ERP system is a simple one-time setup.

To connect to ERP:
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1. Navigate to Integration Manager in the left panel.
2. In the Integrations screen, click Connect next to your ERP system.

Once connected:
> Inbound sync brings master data (plants, assets, locations) into the platform.
> Qutbound transactions are pushed to the ERP automatically.
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11. Manage Maintenance Operations

This chapter covers the key modules that help supervisors and technicians manage work
orders and reported issues in real-time. It includes the Maintenance Control Center (MCC)
and the Observations module, both of which are essential for planning, assigning, and
tracking maintenance activities efficiently.

This chapter has the following topics:

« Use the Maintenance Control Center (MCC) (on page 83)
+ Assign a Work Order to a Technician (on page 84)
» Assign a Work Order at Header and Operation Level (on page 85)

» Review Observations (on page 87)

11.1. Use the Maintenance Control Center (MCC)

The Maintenance Control Center (MCC) is a central module within the iMaintenance
application that helps supervisors efficiently track and manage work orders and operations.

In this module, you can,

« View all work orders, categorized by status and sorted by start date.
« Assign or reassign work orders and individual operations.

« Filter, search, and monitor real-time progress.

 Optimize scheduling, resource utilization, and task completion.

6 Maintenance Control Center Z INNOVAPPTIVE
. Plr Work Ger
m DueToday  DueThisWeek  DueThis Mo Custom 1000 - Hamburg v A - Q =
E:
1 4 14 ]
y‘ Unassigned Work Orders. = Assigned Work Orders = In Progress Work Orders. = Completed Work Orders. =
<
5 o
1102873 - Detector Flow Problem 1102864 - Work Order (No name) AB15ES - Pipe Problem Detected raise flissue
. The detector is experiencing S5 Work Genter - MECH - Mechanical Main The issue is related 10 a pipe, potentially involving leakage,
& a ® blockage, or damage, affecting the overall system
performance and efficiency.
+, . Show 2 Operations >  Work Center : ELEKTRIK - Electrcal main.
> Assign ® acuaton Pianned: ores
&
Show 5 Operations > 1102860 - Detector Coil Replacement Needed 2 1o
The detector coil needs to be replaced, likely due to N
A malfuncion or
Show 1 Operation >
1102833 - SAP Work order 01 & o MECHANIK - Fa
6 SAP Work order 01 B 112025 ®
a S Work Center : MECHANIK -Fabrica Show 4 Operations > 1102882 - Reactor Failure
[chL Oo has stopped fi \g correctly, potentially
HiGH causing production delays hazards
Assig
753A62 - Leaking Pipe with Rust and Damage © ANIK
Show 2 Operations > The pipe is leaking significantly with water spraying out. The [oRD
pipe shows visible signs of rust and damage, with rust o »
HIGH spots covering its surface. The bolts on the pipe flange are.
1102702 - Pump Failure Occurred © Ao

ECHANIK - Fal
ha nimn hae etannad funatinning aranarks ntantialis 1 12:0un-2025 (@]
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View Work Orders by Status

Work orders are categorized into the following tabs:

- Unassigned Work Orders: Not yet assigned to any technician.
- Assigned Work Orders: Assigned but not yet started.

« In Progress: Currently being executed, showing planned vs. actual hours.

« Completed: Finished work orders with detailed performance data.

Search and Filter

You can:

- Use the Search bar (top-right) to find specific work orders.

« Apply filters by clicking the Filter icon, including:
- Date ranges: Due Today, Due This Week, Due This Month, Custom.
o Plants, Revision, Planner Group, and Work Centers.
o Priority levels: Very High, High, Medium, Low.

Configure Fields

You can view, add, or remove fields based on templates defined in RACE, without affecting

existing mobile implementations.

To Configure:

1. Click the Configuration icon next to the Search bar.

2. Under the Field Configurations tab:
o Click the Add Field button to add the fields you need.
o Adjust fields order using the Up and Down arrow icons.
o Delete unnecessary fields using the Delete icon.

11.2. Assign a Work Order to a Technician

Work orders can be assigned directly from the Unassigned Work Orders list.

To assign a work order to a technician:
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1. Navigate to the Maintenance Control Center.
2. Select a work order under Unassigned Work Orders.

<>’\) Maintenance Control Center Z INNOVAPPTIVE
Plant Work Gerters
Lo DueToday =~ DueThisWeek  DueThisMonth  Custom 1000 - Hamburg - Al ~ Q search =
£
11 4 14 0
Unassigned Work Orders = Assigned Work Orders = In Progress Work Orders = Completed Work Orders =
) E= = R
1102873 - Detector Flow Problem 1102860 . ssue
k . Assign WorkOrder X |
. The detector is experiencing a flow issue, potentially *© wel fvolving leakage,
<o affecting ts ability to detect or measure accurately. & 104 Isystem
€ Work Center - MECHANIK - Fabrication W.
10000118 - Fabrication Workshop -
+, 2 11-dun2025 Q© s
e Assign . sonisnex - Planned: 0hrs
o |
Show 5 Operations » 110286(
The dete
S —_—
1102833 - SAP Work order 01 £ wor
B SAP Work order 01 &
€ Work Center: MECHANIK - Fabrication W. Show 4 Operations > l TR
(3 102025 © oms - ‘The reactor has stopped functioning correctly, potentially
Assign causing production delays or safety hazards.
75362 - Leaking Pipe with Rust and Damage £ Work Center : MECHANIK - Fabrication W.
Show 2 Operations > The pipe is leaking significantly with water spraying out. The () 12.0un2025
pipe shows visible signs of rust and damage, with rust © acusto1sine R——
HGH spots covering its surface. The bolts on the pipe flange are.. —
1102702 - Pump Failure Occurred $C Work Center : MECHANIK - Fabrication W. 3 101 Operation In Progress
Tha nimn hae etannad finntinninn nrnark Antantially M 12-3un-2025 @ snrs

3. Click Assign.

4. In the Assignh Work Order pop-up, select the Work Center and Technician (Assignee).
5. Click Assign.

The work order now moves to the Assigned tab and is visible in the technician’s
iMaintenance mobile app.

11.3. Assign a Work Order at Header and Operation Level

You can assign work orders and operations within a work order to different technicians for
more granular task management.

To assign a work order at the header level:

1. In the Maintenance Control Center screen, click Assign for the desired work order.
2. In the Assign Work Order window:

o Select the Work Center from the drop-down.

> Select Assignee from the drop-down list.

> Click Assign.

To assign a work order at the operation level:

iMaintenance Configuration Guide 85




| 11 - Manage Maintenance Operations

3. In the Maintenance Control Center screen, click Show <X> Operation(s) for the desired

work order.

4. In the Operation Details window, click Assign Technician on the operation widget.

P Maintenance Control Center
=
(o] DueToday  Due This Week
=3
11
Unassigned Work Orders =
5 =
A
"
1102873 - Detector Flow Problem
. The detector is experiencing a flow issue, potentially
&o affecting ts ability 10 detect or measure accurately.
+, B 1102025 Ic)
Assign
e
&
Show 5 Operations >
>
S
1102833 - SAP Work order 01
B SAP Work order 01
o o s ®
Assign
Show 2 Operations >
HGH

1102702 - Pump Failure Occurred

Tha niimn hac stnnad finntinninn nrnarhs natantialhs

1000 - Hamburg

4

Assigned Work Orders

HGH
1102864 - Work Order (No ni

5 Work Center : MECH - Mecha
]

show2(

1102860 - Detector Coil Repl
The detector coil needs to be
malfunction or damage.

S Work Center  MECHANK -
=]

Show 4 (
HiGH

753A62 - Leaking Pipe with |
The pipe s leaking significan
pipe shows visible signs of rt
spots covering s surface. Tt
§C Work Center : MECHANIK -
) 12002025

X

Operation Details

1102873 - Detector Flow Problem

Q search Operation

Testing

£ 10000118

£211-3un20:

Kiran /'

25

O+ 21

Remove the damaged pipe

£ 100

£€ 1000011
B 119n
Kiran /"

5. In the Operation Assignment window:

Open (1)

Follow Safety Procedures

10
an

Kiran /*
Block the pipe
€10

an

Kiran /'

X

Operation Assignment

Operation

Work Center

Pending Duration

Planned Duration

slot Resource

Slot1  Select Assignee

+ Add Slot

Cancel

Remove the damaged pipe

MECH - Mechanical Maintenance

15
15

Duration ()

v select - 0

> Select a technician from the Resource drop-down. (The resources list is

displayed based on the Plant).

o Select the operation duration.

> Click Add Resource to assign multiple resources if needed.

o Click Save.

(

Note:

Completed.

> Click Edit next to the technician’'s name to make changes.

> You can change the assignee until the work order is marked as
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12. Review Observations

The Observations module allows supervisors to view and manage issues reported through
the iMaintenance mobile app. These issues are typically tied to specific assets and locations

within a plant.

This section has the following topics:

« View Observations (on page 87)

« Edit Issue Details (on page 87)

» Change Priority with Risk Matrix (on page 88)

12.1. View Observations

To access observations:

1. Click the Observations module in the left navigation.

2. View a list of issues, shown with:

> Status and priority visualizations (graphs).

o Issue title, description, plant, location, and priority.

Figure 12-1 Observations Module

A Observations
2 ovuenatons » toses

m Issues Summary

Pla
B 1000 - Hamburg

“n s

X

¢ @

Pipe Problem

Work Center 1

ork Cer
Al v

Priority

41,659 |

Location/Asset 1+ Priority 1+

1000-CU1-C02-41210-
ELEKTRIK - Electrical mainte. 41210201

12.2. Edit Issue Details

To edit issue details:

Click on an issue.
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In the Issue Details screen, you can,

- Edit Priority
« Change the Start Date & Time
+ Modify the Due Date & Time

&« Pump Issue >

Pump Issue

aaaaaaa

Hamburg

K1-ZPW-1 - Inlet pump plant - spiral pump

10000957 - Pump bearing k1-zpw1 FL

< Date And Time n11,2025,720 P =]

Due Dat Time Jun 25,2025, 7:20 PM [m]

ERP Notification 10047575
sed By Kiran Marri

chment 0

)

12.3. Change Priority with Risk Matrix

To change priority:

1. Click the Priority (e.g., Major, Minor, Moderate, Negligible).
2. In the Preview Matrix window:
> Select values across four categories:
= People
* Assets
» Environment
= Likelihood
> Each category includes questions to evaluate risk level.

iMaintenance Configuration Guide



| 12 - Review Observations

Preview Matrix
Matrix Name

PAER Matrix

v People

What is the potential impact on people in the event of this risk materializing?

[ [ I )

[ | )

What is the likelihood of this risk occurring?

[ s | )

[ Possible 1 [ Negligible ]

What is the potential impact on assets due to this risk?

{ Catastrophic J [

[ Mocerte I

What is the likelihood of this risk occurring?

3. Based on responses, the system calculates the Final Response Criteria (new priority).
4. Click Update to apply changes.

This ensures consistent, risk-based prioritization of reported issues.
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Forms are essential for capturing structured field data in the iMaintenance mobile
application. This chapter covers everything from manually creating and publishing forms to

leveraging Al for auto-generation to managing archived forms.

This section has the following topics:

- Create & Publish Forms. (on page 90)
« Auto Assign Forms (on page 95)
» Add Measuring Point Section (on page 97)

« Use Generative Al to Create Forms (on page 99)

13.1. Create and Publish Forms

Build forms using a visual builder that lets you define pages, sections, questions, and
response types. These forms can be tailored to different inspection or reporting scenarios,
improving consistency and usability in the field.

You can also configure which fields should be auto-populated and set them as editable or

read-only based on your requirements.

To create and publish a form:

1. Expand the Forms module.

2. Click Embedded Forms in the left menu.

3. Click Create New on the right side.

4. In the Form Details screen, provide the following:

Field Description
Form Name Enter a name (e.g., EQuipment Inspection).
Description Describe the purpose of the form.
Instance Type Select Single or Multiple Instance.
Plant Select the applicable plant.
Tags Add tags to categorize the form.
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Field

Description

Auto Assignment of Forms

Assign Forms based on Equipment, Func-
tional Location, Tasklist, Maintenance Plan
and Work order Type.

Measuring Point Section

Add Measuring Point category of Equip-
ment and Functional location.

Additional Details

(Optional) Add custom fields with La-
bels (max 25 chars) and Values (max 40
chars).

Figure 13-1 Add Form Details

< Back o List

uuuuuuuuuu

Auto Assign Form

5. Click Next.

6. In the Add Fields screen, a default section with 4 fields is auto-populated to help you

get started. Here you can:

- Add Pages, then Sections within each page.

> Insert Fields (Questions) into sections.

- Select Response Type (text, multiple choice, slider, etc.)

> Rename, reorder, or delete fields and change response types as needed.

> Rename sections to match your workflow.

Each Response Type is a field/input type used in the Authoring Module of Platform

modules.
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Response Type Description Supported Properties
Read Only Displays reference data. No | Add Logic, Default Value,
user input allowed. Localization, Enable, Re-
quired, Input Data.
Text Free text input (e.g., title, Add Logic, Default Value,
descriptions). Additional Details, Localiza-
tion, Enable, Required, Type
Number Numeric values field Add Logic, Default Value,
Additional Details, Localiza-
tion, Enable, Required, Unit,
History, Range, Formula,
and Unit of Measurement
(UoM)
Date & Time Calendar input for date & | Additional Details, Localiza-
time values. tion, Enable, Required, Date
& Time Format
Signature Captures digital signatures | Additional Details, Localiza-
from users. tion, Enable, Required
Scan Uses device camera to Additional Details, Localiza-
scan QR/barcode. tion, Enable, Required
Hyperlink Clickable link to web or Additional Details, Localiza-
document resources. tion, Enable, Required, Add
Link
User Selects a user from the Add Logic, Default Value,
system. Additional Details, Localiza-
tion, Enable, Required
Slider Selects a value from a de- | Add Logic, Default Value,
fined scale. Additional Details, Local-
ization, Enable, Required,
Range, History
Geo Location Captures GPS location of Additional Details, Localiza-
user. tion, Enable, Required
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Response Type

Description

Supported Properties

Add Photo

Upload images for visual
evidence.

Additional Details, Localiza-
tion, Enable, Required

Form

Embeds a nested form
within the main form.

Add Logic, Forms, Field
Configurations, Additional
Details, Localization, Enable,
Required.

Search Text

Searchable text field for se-
lecting values from Drop-
down.

Add Logic, Input Data, Lo-
calization, Enable, Required

Instructions

Displays non-editable in-
structional text.

Additional Details, Enable,
Required, Add Tags, Add
Files, icons and images.

Array List Field group (e.g. items, Additional Details, Localiza-
causes). tion, Enable, Required, Input
Data.
Date Range Selects a start and end Additional Details, Localiza-
date. tion, Enable, Required
Attachments Uploads documents or files | Additional Details, Localiza-
(PDFs, DOCs, Voice, Image, |[tion, Enable, Required, At-
etc.). tachment Details
Checkbox Boolean input for Yes/No | Add Logic, Additional De-
selection. tails, Localization, Enable,
Required
Toggle Ul toggle for ON/OFF selec- | Add Logic, Localization, En-
tion. able, Required.
Risk Matrix Triggers a configurable risk | Add Logic, Additional De-

priorities drop-down values

tails, Localization, Enable,
Required

Scan Search Text

Scan barcode to search
and drop-down to select
values.

Add Logic, Localization, En-
able, Required, Input Data
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Response Type Description Supported Properties

Insert Image Add a single image Additional Details, Localiza-

tion, Enable, Required

> Set conditions or logic (e.g., show/hide based on answers) as shown in the below
table.
> Mark fields as Required, enable History, or apply Localization.

Response Type Properties

Add Logic

Enables conditional rules for a field
(show/hide Field/Section, Raise Issue,
Mandatory field/Section etc.) based on
field values.

Default Value

Pre-fills the field with a value when the
form loads in mobile application.

Additional Details

Allows admin to define character limit or

extra metadata for users.

Localization Allows admin to translate field labels into
multiple languages.

Enable Toggles whether the field is active and
visible in the consumption.

Required Marks the field as mandatory for submis-
sion.

Input Data Allow admin to define collection of
dataset for field.

Unit Allows admins to select a unit of mea-
surement (e.g. °C, Kg, hrs) to numeric
fields.

History Allows admin stores previous values en-
tered in the field.

Range Sets a minimum and maximum limit for

values (typically in number or slider).
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Formula Supports calculated values based on oth-
er Numeric field inputs.

Date & Time Allows admin to define which date format
should be used in the consumption.

Add Link Allows the field to point to an external URL
or system reference.

Type Defines the technical input format (e.g.,
string, number, object) — mostly sys-
tem-managed.

Upload Files Allows users to attach images, PDFs, or
documents to the field.

Add Tags Lets admin apply metadata tags for filter-
ing, grouping, or analytics.

Figure 13-2 Add Questions

< Backto List @ romdetaiis @ raarieias

ppppppp

Cancel
FO161 - Pump Leak

Measuring Points Section A

Reading

- Use Preview (right side) to see how the form appears in the mobile app.
7. Once done, click Publish.

The form is now live and visible in the My Forms screen with Published status. It is also
posted to SAP based on the configuration.

13.2. Auto Assign Forms

Set up rules to automatically assign embedded forms to Work Orders based on criteria such
as Equipment, Functional Location, Task List, Maintenance Plan, Order Type, or other attributes.
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Configure Auto Assignment

To configure auto assignment:

1. Add Auto Assignment Rule
> Click the Add button under the Auto Assign Forms section.
> A pop-up window will open with a tabbed view.

2. Define Assignment Criteria

The pop-up has four tabs, each representing a criteria type:

a. Functional Location [ Equipment
= View a hierarchical structure of functional locations and equipment
related to the selected Plant.
= Select one or more nodes where the form should auto-attach.
b. Work Order Type
= Displays a list of available WO types.
= Use checkboxes to select one or multiple types.
c¢. Maintenance Plan
= Displays all available maintenance plans.
= Multi-select support is available.
d. Task List
= Displays task lists.
= Supervisors can select one or more lists for auto-assignment.
3. Save & Apply
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o After making selections in one or more tabs, click Save.
> The form will now automatically attach whenever a record (WO, EQ, FL,
Maintenance Plan, or Task List) matches the configured conditions.

Note:

Mobile Behavior: Auto-attached forms are visible in the WO/Notification

detail screen on mobile.

Figure 13-3 Auto Assign Forms

Select Fields

Functional Location & Equipment Work Order Type Maintenance Pian Task List

O @ o mreusotora
@ 1000
1D: 1000
@ 100ERBAD
1D: HYD
I 2000004
1D: 2009004
2 2009005
1D: 2009005

I 2000006
1D: 2009006

I 3W EMERGENCY GENERATOR MECH CHECKS
1D: IE01

K2 3w EMERGENCY GENERATOR MECH CHECKS
ID: 10143673

@ AFuNCLOC

13.3. Add Meadsuring Point Section

The Measuring Points (MP) feature enables form creators to configure a dedicated section
for capturing MP readings during the form authoring or publishing stage. This ensures
seamless integration with Equipment (EQ) and Functional Location (FLOC) headers, allowing
mobile users to view and record relevant MP data directly within the form.

To add or configure the measuring point section:
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1. Add Measuring Point Section

In the Form Details, click Add Measuring Point Section.

2. Select EQ/FLOC with Measuring Point Category.
a. Choose whether the MP section should be tied to:
« Equipment (EQ)
» Functional Location (FLOC)
= Both
b. Select Measuring Point Categories (e.g., M, N, P).
c. Each chosen category will create an individual MP subsection within the form.

d. Example: Selecting M and N will display two subsections in mobile, each showing
MPs belonging to that category.

This ensures MPs are pulled dynamically from the appropriate header context.

3. Publish Form

a. Once published, the form configuration stores metadata for the MP section.
b. On mobile, the section will:

» Fetch MPs via API using EQ/FLOC values.

= Display MPs grouped by category.

= Allow users to capture readings directly.

Mobile Experience
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> The MP section will appear in the form at the configured position.

> MPs are fetched dynamically based on header-level EQ/FLOC.

- Each MP will display fields for data entry (e.g., value, unit, timestamp).
> MP Count will be shown per EQ/FLOC for better user visibility.

o If no MPs exist — section displays “No Measuring Points available”.

Figure 13-4 Add Measuring Points

Equipment

Functional Location

Add Measuring Point Sections

13.4. Use Generative Al to Create Forms

You can speed up form creation by using Al to either describe the form you need or upload

an image/pdf of a physical form.

Table 13-1Two Al-driven options:

Option

Description

Upload and Convert

Converts scanned images or PDFs of paper
forms into digital forms.

Describe Your Form

Al reads a prompt or attached reference

docs and auto-generates a form.
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Upload and Convert

1. Navigate to the Forms module and click Create using Al.
2. In the Choose a Starting Point screen, select Upload and Convert.

Figure 13-5 Choose Starting Point

€ BacktoList

Choose a Starting Point

& *

Upload and Convert OR Describe your Form
Convert Images of paper based forms Al will analyze your prompt to generate a
directly into CWP digital format form. For a better output, attach reference
documents

3. In the Generate Using Al screen, choose:
> Plant
- Instance Type (Single/Multiple).

€ Backto List o Generate using Al

cancel Continue

Upload and Convert

Convert Images, PDF, Excel, Word based forms directly into digital format

Work Order Embedded

‘‘‘‘‘‘‘‘‘‘ model from Openal

4. Upload the image or PDF of the form.
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5. Click Continue.
6. Al generates the form with relevant sections and fields.

7. In the Review Questions screen, make changes if needed and click Publish.

Figure 13-6 Review Questions

& Backto List o Generate using Al ° Review Questions

% 7 Plant: 1000 - Hamburg

222 aT.
v Page

Cancel  Create Form

% v Basic Information

Basic Information ~

+ Boiler Temperaturd T Text folr Temperature
o
(® Ask Question Logic Format : Short Text Additional Details: Localisation I Enable Required
System Configuration v
+ Add Field

5 Add Section

Describe Your Form

1. In Choose a Starting Point screen, select Describe Your Form.

2. In the Generate using Al screen, enter a prompt in the text field.
3. Select:

> Plant
- Instance Type (Single/Multiple).

<« Back to List

© cencaeusng

+, Create Using Al

Al will generate a form based on your prompt. Attach reference documents for better results.

Work Order Embedded - -

Suggestions.

Create a form in English for Daily inspection of CRI Pressure

Create a Monthly Inspection form in Spanish to meet OSHA
Booster Pumps in Oil and Gas Industry

Regulation in my Chemical Plant

nnnnnnnn mode from OpenAl

4. (Optional) Attach reference documents.
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5. Click Enter.
Al generates the form with relevant sections and fields.
6. Click Continue.
7. In the Review Questions screen, review and edit the generated form.
8. Click Publish.

Form Management Actions

In the My Forms screen, you can,

« Edit a form: Click the More icon next to a form > Edit.
« Copy a form: More icon > Copy.
« Archive a form: More icon > Archive.

Archived forms appear in the Archived module.

13.5. Bulk Upload Forms

Upload multiple forms at once using a pre-defined Excel template to streamline form
creation

To bulk upload forms:

1. Expand Forms and select Embedded Forms.

2. Click the More icon on the top right corner and select Download Excel Template.
3. Fill out the Excel sheet.

4. Click Create New > Upload Excel.

5. Select and upload the file.
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14. Set Up Configurations with RACE

The RACE (Rapid Application Configuration Engine) module is the administrative toolkit

that allows you to define how forms work on mobile, localize the platform's language, and

optimize mobile data sync behavior by user roles. These configurations help tailor the

iMaintenance experience without requiring code changes.

Figure 14-1 Field Configurations

= Field Configurations
~ RACE > Field Configurations
m
Templates
2
Name
>3 Excavation
* B permits
B [ Permits-Form-
Basic Materials
o
[  AlResponse
*
[3  Permits Forms
s
&
y‘ B Measuring Doc
.
[ Permits-Form-
B Financials
el [ RoundPlan
Check
[ Permits-Form-

Technology

Status 1L

Published

Plant T

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

1000 - Hamburg

Template Type TL

Permits

Permits

Permits

Permits

Measuring Point
Document

Permits

Damages

Permits

Last Published By 1.

Alekhya m Merugumilli

Q Ssea

Last Published Tl

3 months ago

3 months ago

3 months ago

3 months ago

2 days ago

3 months ago

3 months ago

3 months ago

Z5 INNOVAPPTIVE

Created By 11

This chapter has the following topics:

» Create Field Configurations Templates (on page 103)

» Manage Localization (on page 123)

14.1. Create Field Configurations Templates

T Actions

Field Templates are reusable form structures used in the mobile app for issue reporting,

inspections, and other workflows. You can define pages, sections, and tasks and configure

how users interact with the form.

To create and publish a template:
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1. Navigate to RACE > Field Configurations.

2. Click Create New on the top-right and select Create Manually.

Figure 14-2 Create New

Field Configurations
RACE > Field Configurations

Templates

Name

B

B

3. In the Template Details screen:

Excavation
Permits

Permits-Form-
Basic Materials

All Response

Permits Forms

Measuring Doc

Permits-Form-
Financlals

Status 1L Plant 11

1000 -

1000 -

1000 -

1000 -

Hamburg

Hamburg

Hamburg

Hamburg

Hamburg

Hamburg

Template Type 1L Last Published By Tl

Permits

Permits

Permits

Permits

Measuring Point

Document Alekhya m Merugumilli

Permits

> Choose Template Type such as:

= Issues

= Work Order

= Components
= Operations

= Permits

= Measuring Point

- ltems

= Causes

= Damages
= Activity

= Tasks

= Measuring Point Document

= Timesheet

* EQuipment Details

= Functional Location Details

o Enter Template Name.

> Add Description.

> Select Plant.
> Add Tags.

> Click Next on the top-right.
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Q  Scarcl

Last Published 1L

3months ago

3months ago

3months ago

3months ago

2 days ago

3 moenths ago

Created By Tl
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Figure 14-3 Template Details Screen

& Backto List o Template Details 2
]

Template Details
Template Type *

Issues e

Template Name *

Asset lssuc Template

Description

Asset Issue Template

Plant *

1000 - Hamburg -
Tags

issues notification

4. In the Add Fields screen:
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- Add Sections and Tasks.

- Define Response Types (e.g., Text, Number, Signature, and so on).
> Preview the mobile layout on the right.

o Click Publish to make the template live.

Figure 14-4 Add Fields Screen

< Backto List

° Template Details o Add Fields

B Control Valve Mainten... 7 Plant: 1000 - Hamburg
Add Description
12:43 alT -
v Page 5
Cancel  Create Form
.. - " ~
22 v Untitled Section
+ y Site Conducted
Site Conducted 1.controls
= 1
u]
Output Data : Extension | Enable O Required 3 Allow Multi-Select 7 Key Name
¢ Conducted On B Date & Time
Performed By T Text
Conducted On
Location © Geo Location MM/DD/YYYY [G]
label T Text
Performed By
+ Add Field
3 Add Section
Location
Enter Location ®

A Note: )

o Use the More icon and select Edit to edit the details.

> Only one template is allowed per plant. You cannot create multiple
templates for the same plant.

N

14.1.1. Configure Work Order Creation Template

Work Orders are core to iMaintenance. As an Admin or Supervisor, you can configure the Work
Order template using Out-of-the-Box (OOTB) fields—adding or removing fields as needed.

To configure a work order template:
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1. Expand the RACE module and click Field Configurations.

2. Click Create on the top-right and select Create Manually.

3. In the Template Details screen:

. Select the Template Type as Work Order.

a

b. Enter Template Name.
c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.

Figure 14-5 Work Order Template

< Back to List

Template Details

Template Type

4. In the Add Fields screen:

a. Add Sections and Tasks (fields) and define response types (behavior) as shown

in the table below.

Field Name

Platform Behavior

Work Order Title

Free-text; mandatory

Work Order Description

Free-text; mandatory

Priority

Drop-down; configurable via Risk Matrix

Equipment

Drop-down with search and scan

Functional Location

Drop-down with search

Work Order Type

Mandatory; default per persona

User Status

Auto-filled from SAP or editable

Assign Technician

Select from active users by workcenter
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Work Center Auto-populates based on FL or Equip-
ment

Planning Plant Synced from user profile or FL

Maintenance Plant Derived from Equipment or FL

Work Order Start Date Date picker; validation logic

Work Order End Date Must be 2 start date

Operations, Components, Permits, Nested templates; config separately

Forms

Attachments Upload; 5MB limit, supports PDF/IMG/
MP4

Figure 14-6 Work Order Template Fields

& Back to List @ remplaie petails © ~udrieias

WO Template
Add Description

nnnnnnnnnnnnnnn

5. Click Publish.

14.1.2. Configure Issue Creation Template

Issues are linked to SAP Notifications, and templates define the data captured for safety,
maintenance, or quality reporting. As an Admin or Supervisor, you can configure the Issue
template using OOTB fields.

To configure an issue template:
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1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Issue.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.

Figure 14-7 Issue Template

& Back to List @ rempiate petaits

Template Details

Template Type

4. In the Add Fields screen:
a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior

Title Mandatory free-text

Description Mandatory Free text

Priority Drop-down, auto-color coded from Risk Matrix

Equipment Linked to FL; auto-populate logic; Drop-down with Search
and Scan

Functional Loca- |Hierarchical search with drop-down
tion

Attachments File/image support (limit: 25MB)
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Notification Type |Default per plant; configurable

Maintenance Drop-down with search option
Plant

Planning Plant Drop-down with search option
Work Center Drop-down with search option

Required Start Date Field
Date

Required End Date Field
Date

Figure 14-8 Issue Template Fields
< Back to List @ remplare petails @ ~ddFielas

Issue Template

Plant: 1000 - Hamburg

5. Click Publish.

14.1.3. Configure Operation Template

Operations define the individual tasks within a Work Order. As an Admin or Supervisor, you
can customize the Operation template using OOTB fields. Each Operations template is linked
to its corresponding Work Order template for consistent task management.

To configure an operation template:
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1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Operation.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.

Figure 14-9 Operation Template

& Back to List o Template Details

Template Details

Template Type
Template Name

Description

4. In the Add Fields screen:
a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior

Operation Activity | Auto-incremented activity number

Description Free-text field

Work Center Drop-down with search option

Control Key Drop-down Defines execution type

Plant Drop-down; Auto populate based on WO/Issue
Planning Plant Drop-down with search option

Activity Type Drop-down field

No. of Resources |Number field
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Work Total effort in person-hours; Number field
Unit of Work Number Field

Duration Duration in unit; Number field

Start Date Date Field

End Date Date Field

Figure 14-10 Operation Template Fields

< Back to List @ rempiare oetails @ radFielss

Operations

9
g
=
g § 2 s 32
B W

5. Click Publish.

14.1.4. Configure Issue Slip Template

((((((((

As an Admin or Supervisor, you can customize the Issue Slip template using OOTB fields. The

Issue Slip template is linked to the corresponding Work Order template.

To configure an issue slip template:

1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Issue Slip.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.
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Figure 14-11 Issue Slip Template

< @ rerpievetis

Template Details
Template Type

Issue Sip

Template Name

Issue Slip Template

Doscription

Plant

1000 - Hamburg

4. In the Add Fields screen:
a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior

Reservation Number | Read Only Field

Movement Type Read Only Field

Plant Read Only Field
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Work Order Read Only Field
Created Date Date & Time
Response Email Text

Goods Recipient

Search Text

Figure 14-12 Issue Slip Template Fields

<& Back to List

Operations

@ remoiace oerais

Add Fields

Sections

5. Click Publish.

14.1.5. Configure Component Template

BB B

nnnnnnnnnnn

Components represent materials like spare parts and consumables linked to Work Orders. As

an Admin or Supervisor, you can customize the Component template using OOTB fields. The

Component template is linked to the corresponding Work Order template.

To configure a component template:

1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.

3. In the Template Details screen:

a. Select the Template Type as Component.
b. Enter Template Name.

c. Add Description.
d. Select Plant.

e. Add Tags.

f. Click Next.
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Figure 14-13 Component Template

& Back to List @ e

Template Details

Template Type

4. In the Add Fields screen:
a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior

Material Number Number Field

Material Description | Auto-populated

Item Category Drop-down field with search

iMaintenance Configuration Guide 115



| 14 - Set Up Configurations with RACE

Required Quantity

Mandatory, Number field

Unit of Measurement

Auto-populate from material master

Storage Location

Drop-down with Search

Link to Operation

Drop-down of existing operations

Figure 14-14 Component Template Fields

< Back to List

Components

@ rempiec ocas © ruarioss

5. Click Publish.

14.1.6. Configure Iltem Template

Items represent materials linked to Issues, such as parts or consumables. As an Admin or
Supervisor, you can customize the Item template using OOTB fields. The Item template is

connected to the corresponding Issue template.

To configure an item template:

1. Expand the RACE module and click Field Configurations.

2. Click Create on the top-right and select Create Manually.

3. In the Template Details screen:

a. Select the Template Type as Item.

b. Enter Template Name.

c. Add Description.
d. Select Plant.

e. Add Tags.

f. Click Next.
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Figure 14-15 Item Template

< Back to List @ rempiate peails

Template Details

Template Type

4. In the Add Fields screen:

a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior
ltem number Auto incremental value
Iltem Code group Drop-down with search
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Object part code Auto populates from Item Code Group

Damage Code group | Drop-down with search

Damage part code | Auto Populates

ltem short text Text field

Figure 14-16 Issue Template Fields

< Back to List @ rempiare peails © ~ddrieldss

Issue Item

aaaaaaaaaaa

5. Click Publish.

14.1.7. Configure Cause Template

Causes capture the root reason behind an issue and are linked to the Issue. As an Admin or
Supervisor, you can customize the Causes template using OOTB fields. The Cause template is
associated with the corresponding Issue template.

To configure a cause template:

1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Cause.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.
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Figure 14-17 Cause Template
& Back to List o Template Details

Template Details

Template Type

Description
Plant -

Tags

4. In the Add Fields screen:

a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior
Cause number Auto incremental value; Read Only Field
Iltem number Drop-down with search

Cause code group | Drop-down with search

Cause code Auto-populates from Code group; Read Only

Cause text Text Field

Figure 14-18 Cause Template Fields

< Back to List @ rempiare peraiis @ ~darieids

Issue Causes

+ Cause Number @ Read Only
a

0 0 Output Data : Cause Number | B
v m Numb

= search Text
code group = Search Text Cause code group

T Text

Cause Code Description

@ Read Only Ccause Text
e Code Id @ Read Only

w field 423 Number
i

cause Codeld

5. Click Publish.
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14.1.8. Configure Activity Template

Activities are detailed tasks within an Issue, used to track execution, performance, and
compliance. As an Admin or Supervisor, you can customize the Activity template using
OOTB fields. Each Activity template is linked to the corresponding Issue template, enabling
structured task management and reporting.

To configure an activity template:

1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Activity.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.

Figure 14-19 Activity Template

& Back to List @ rermpiate petails
E =3
Template Details
4. In the Add Fields screen:
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a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior

Activity number Auto populates Incremental Number

Item number Auto populate based on Item Field Configura-
tions

Activity code group Drop-down with Search

Activity code (Auto popu- Auto-populated from code group

late)

Activity short text Describes Activity; a text field

Figure 14-20 Activity Template Fields

& Backto List @ remplare pevails © rddrields

Issue Activity

5. Click Publish.

14.1.9. Configure Task Template

Tasks represent specific actions within an Issue and are configured using Task templates. As
an Admin or Supervisor, you can customize the Task template using OOTB fields. Each Task
template is linked to the corresponding Issue template, ensuring consistent action.

To configure a task template:
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1. Expand the RACE module and click Field Configurations.
2. Click Create on the top-right and select Create Manually.
3. In the Template Details screen:

a. Select the Template Type as Task.

b. Enter Template Name.

c. Add Description.

d. Select Plant.

e. Add Tags.

f. Click Next.

Figure 14-21 Task Template

& Back to List @ rermplate peals

Template Details

Template Type

Template Name ~

Issue Tasks

4. In the Add Fields screen:
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a. Add Sections and Tasks (fields) and define response types (behavior) as shown
in the table below.

Field Behavior
Task number Auto populates Incremental Number
Item number Auto populate based on Item Field Configurations

Task code group | Drop-down with Search

Task code Auto-populated from task group

Task short text Describes task; a text field

Figure 14-22 Task Template Fields

& Back o List @ rempicre evails @ raariolas

Issue Tasks

Plant: 1000 - Hamburg

v Task Number © Readonly

Task code group = SearchText Task code group
‘Task Code Group Description @ Read Only

Task code ID @ Read Only Task Code Group Description

5. Click Publish.

14.2. Manage Localization

The Localization feature allows Admins to manage language translations for all Innovapptive
products—both web and mobile. It's particularly useful for aligning Ul terms with local
business terminology or translating content into regional languages.

To add a new language:
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1. Expand RACE and click Localization.
2. Click Add Language and select Add Manually.

Figure 14-23 Localization Screen

i RACE Z5 INNOVAPPTIVE
~ RACE > Localisation hd
m Product
WP +6 - T6languages Q@  Search = Add Language -
e
Languages 1 Products 11 Product Type 11 Strings Translated 11 Last Modified On 1! Last Modified By 11 Status 11 Actions
\,
A
English Default cwp2 Web 2096/2096 Yesterday Sahil Kumar Published
English Default mWorkOrder Mobile 1145/1145 7 days ago AryaD [ Published
&
French (Metropolitan) mWorkOrder Mobile 1145/1145 8 days ago Alekhya m Merugumilli [ Pubished J
*.
English (India) mWorkOrder Mobile 1145/1145 8 days ago AryaD Published
&
Afrikaans minventory Mobile 0/380 12 days ago Jayaraju Metta
R French (Acadian) cwp2 Web 2079/2079 14 days ago AryaD [ Pubished J
B Spanish (Argentine) cwp2 Web 2079/2079 14 days ago AryaD Published
o Catalan (Valencian) cwp Web 0/2863 22 days ago Alekhya m Merugumill
Albanian (Gheg) mAssetTag Mobile 0/2965 Amonth ago Alekhya supe supervisor

3. In the Add Language window, select the Language and applicable Products.

Figure 14-24 Add Language

Product

CWP +6 - 16Lanquages Q  Search = Add Language

Languages Tl Products 1L Product Type TL Strings Translated 1L Last Modified On Tl Last Modified By I Status TL A

Default
English cwp2 Add Language X Sahil Kumar [ Pubiished ]

English Default mWorkOrder [ AryaD [ Pubiished ]

Spanish (Argentine)

French (Metropolitan) mWorkOrder Alekhya m Merugumill [ Pubiished ]
SetectFrocucts

English (India) mWorkOrder CWP mRounds, mWorkOrder A AryaD [ Pubiished ]

Afrikaans minventory Jayaraju Metta

French (Acadian) cwWP2 - AryaD [ Pubiished ]
Spanish (Argentine) cwp2 Web 2079/2079 14 days ago AryaD [ Pubiished ]

Catalan (Valencian) cwp Web 0/2863 22 days ago Alekhya m Merugunill

4. Click Done.

The newly created language is displayed in the list.

5. Click the More icon and select Edit.

You can view the total translated string count for that product in its released version.

6. Translate all the strings for the selected language.
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Figure 14-25 Translate Strings

< French (Acadian) - CWP2 (Web)

Q_  Search by Field / Default / Language Names Publish -

Field Name English (Default) French (Acadian) - draft French (Acadian) - published 1
searchWorkorders Search Work Orders Rechercher des ordres de travall Rechercher des ordres de travall
filter Tilter Tiltre Tiltre
showOverdue Show Overdue Afficher en retard Afficher en retard
priority Priority Priorité Priorite
killingStalus Killing Stalus Elal de préparation Elal de préparalion
apply Apply Appliquer Appliquer
reset Reset Réinitialiser Réinitialiser
dueloday Due loday Da aujourdnui D4 aujourd'hui
dueThisWeek Due This Week DA celle sernaine Di celle semaine
ducThisMonth Duc This Month DA ce mois ci Di ce mois ci
2079/2079 Strings Translated 100% Show Empty Strings

7. Click More icon on the top right.
> Select Clear All Strings to clear all strings at once.
- Select Refresh Al Translations to use Al suggestions and clear them if needed.

Note:

Select the Show Empty Strings toggle at the bottom to quickly view the empty

strings.

8. Once all the strings are translated, click Publish.

In the Localization screen, you can also,
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> Select the Product drop-down to view All Products or individual products (e.g.,
CWP Web, iMaintenance Mobile, etc.) By default, the filter is applied to ‘All
Products’, showing all languages across all products.

> Click on the Sort icon next to each column header to sort alphabetically,
numerically, or by date.

> View the number of languages currently listed in the table (e.g., “18 Languages”)
at the top.

> Use the Search bar at the top right to quickly find a specific language or product.

> Use the Filter icon to filter the list based on Last Modified On or Last Modified By.

o Click Add Language and select Upload Excel to upload translations via Excel
templates.

> Click the More icon and select Download Excel Template to download the
template.
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15. Configure Risk Evaluation with the Risk
Matrix

The Risk Matrix is a powerful configuration tool that lets you define how risks are calculated
and prioritized based on incident data. It supports consistent and objective decision-making
across inspections, observations, and safety reporting.

Earlier: In many maintenance and safety programs I've seen, risk assessments were either
one-size-fits-all or stuck in rigid templates. Teams had to rely on paper forms or inflexible
tools where updating risk criteria—like likelihood or severity—meant IT involvement or a long
wait for customization.

The result?

Risk evaluations that didn't reflect real-world changes or site-specific conditions. Worse,
teams often skipped the process altogether because it felt disconnected from their actual
workflows.

This led to two major problems:

+ Outdated or irrelevant risk profiles — creating blind spots in hazard identification.
« Low user adoption — because the tools didn't match how frontline teams actually work.

Now, configuring a Risk Assessment Matrix is completely no-code and flexible. With our
platform, EHS managers or planners can tailor the matrix—severity, likelihood, risk levels, color
coding—to match company policies or evolving field realities, all without a developer. You
can update parameters instantly, deploy them across teams, and ensure everyone is using

the latest risk model—whether they're on-site or remote.

As an outcome - Smarter risk decisions, higher compliance, and a safety culture that adapts
as fast as your operations do.”

15.1. Create a Risk Matrix

To create a risk matrix:
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1. Navigate to RACE and select Risk Matrix.

2. Click Create Matrix.

Figure 15-1 Create Risk Matrix

RACE

RACE > Risk Matrix

Open Matrix Archived Matrix
Matrix Name 14 Description Tt

Priority Matrix Matrix for People Asset Envi.
PAER Matrix Matrix for People Asset Envi.
mat-array

ariahidden Copy 1

Plant 1l

Hamburg

Hamburg

Hamburg

Hamburg

Tags L

People, Asset, Environment,

People, Asset, Environment,

Q_  search

Status |

3. In the Risk Matrix Details screen, enter Matrix Metadata:

> Matrix Name
> Matrix Description
o Plant

- Category (Issue or Work Order)

> Type
o Prioritization Profile
> Tags

> Define matrix components (e.g., Consequences, Likelihood)

o Click Next.

Figure 15-2 Risk Matrix Details

< @ riskMatrix Details

Risk Matrix Details

Matrix Name *
Priority Matrix

Matrix Description

o Add Consequences

© Ao tiketinoo

Matrix for People Asset Environment and Reputation

Plant *
1000-Hamburg
Tags

People &

Asset @

This Matrix will include

Consequences

4. In the Add Consequences screen, add consequences,

iMaintenance Configuration Guide

Environment €

Reputation

Likelihood

o Configure Priorities

Created By 1L

Nagarjuna Kola

Sagar Arora

Jayaraju Metta

Jayaraju Metta

Z INNOVAPPTIVE

Create Matrix

Actions

© cenerate Maix
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o Click the + Add Consequences button at the right-side.
o Select the relevant color in the Color column.
- Define up to 5 consequence categories (e.g., People, Assets, Environment).
= Add an evaluation question for each category.
» Define severity levels (0-5) with:
= Alabel
= A scenario
= A description
> You can add or remove levels as needed.
o Click Next.

Figure 15-3 Add Consequences

< © risk Matrix Details © . consequences © A Liketinood © configure priorties © cenercte Matrix
‘: Previous Next
Severity Consequences On People Consequences On Assets Consequences On Likelihood
What is the potential impact on people in the event of this risk materializing? ~ What is the potential impact on assets due to this risk? What is the potential environmental

Level Color Scenario Description: Scenario Description: Scenario

0 . Catastrophic More than 3 fatalities or pern Catastrophic Complete destruction or loss Catastrophic

1 Major 1-3 fatalities or permanent di Major Severe damage requiring sigr Moderate

2 o Moderate Serious injuries requiring hos Moderate Damage causing limited dow Minor

3 . Low No significant injuries; minor Low Minimal impact; repair costs Negligible

+ Add level (Max 7)

5. In the Add Likelihood screen, add Likelihood.
o Click + Add Case at the bottom.
> Select the relevant color in the Color column.
- Define scenario in the Likelihood of occurrence column.
> Add a description in the Description field.

Note:

You can add maximum 7 cases.

o Click Next.
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Figure 15-4 Add Likelihood

< o Risk Matrix Details o Add Consequences o Add Likelihood o Configure Priorities o Generate Matrix

‘ prefious ‘ “

Likelihood
What is the likelihood of this risk occurring?
Case Color Likelihood of occurrence Description:
A . Almost Certain Likely to occur within 3 montl
B Likely Likely to occur within 3 montl
[ . Possible Might happen within the next
D ' Negligible Likely to occur within 3 montl

+ Add Case (Max 7)

6. In the Configure Priorities screen, configure Priorities.

o Click the + Add Results button at the bottom.

- Assign priorities (0, 1, 2..) based on consequence and likelihood combinations:
» Name the risk results.
= Select start date and end date.
- Set response timeframes (e.g, 1 Day, 2 Weeks).
= Map risk level values to ABC indicators per plant, issue or work order (e.g.,

High risk level can be mapped to both A and B classes.

= Rank results from highest to lowest if needed.

> Click Next.

Figure 15-5 Configure Priorities

& Backto List 0 Risk Matrix Details o dd Consequences o Adc Likelihood o Configure Priorities o Generate Matix
o

Configure Matrix

Rank Priorities and Risk Result from Highest to Lowest

Priority Color Risk Result Start Date End Date Complete Within ABC Indicator
v [ ] Very High Tv Day v v Day v 2v Hv v
2v High 2v Days v 2v Days v 2v Days v 2v
3v Medium 4v Days v S5v Days v Tv Week v 3v

+ Add Results (Max 20)
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7. In the Generate Matrix screen, generate the matrix:
o Review the color-coded matrix.
- Each cell represents a risk level (e.g., Very High, Medium).
> Click on the cell to change the risk level.
> Click Preview to view risk matrix in its final form.

Figure 15-6 Matrix Preview

Preview Matrix X

Matrix Name

Priority Matrix

What is the potential impact on people in the event of this risk materializing?

Catastrophic Major
Moderate Low

What is the likelihood of this risk occurring?

Almost Certain Likely

Possible Negligible

What is the potential impact on assets due to this risk?

o Click Publish.

Figure 15-7 Generate Matrix

é o Risk Matrix Details o Add Consequences o Add Likelihood o Configure Priorities ° Generate Matrix

Priority Matrix

People Assets Likelihood Almost Certain Likely Possible Negligible

Catastrophic Catastrophic Catastrophic - -
RS

The matrix is now available for use in incident reporting or form configurations.

Moderate Moderate Minor

Use More icon to Edit, Copy, Preview, or Archive a matrix.
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16. Customize Platform Settings

The Settings module provides administrators with the tools to manage platform-wide
preferences that directly affect the iMaintenance mobile application. These settings include
storage behavior, theme configurations, and sync options that enhance user experience and

app performance.

This chapter has the following topics:

» Manage Storage & Sync Settings (on page 132)
» Apply Theme Configurations (on page 134)
« Define Mobile Data Sync Preferences (on page 133)

16.1. Manage Storage & Sync Settings

The Storage tab under General Settings allows admins to control how the mobile app
handles datg, including cache management and full sync initiation.

To manage storage and sync settings:

1. Navigate to Settings and click the Storage tab.
2. Select the Product (e.g., iMaintenance).
3. Enable or disable the storage related settings and click Publish.

Figure 16-1 Storage Settings

A Settings £ INNOVAPPTIVE
~ Settings > General <
m
Product
mWorkOrder e Publish
2y
%
. Storage Theme
Storage Configurations
.'g You can control storage related settings for mobile applications.
*, . .
(8 Re-initiate the Initial Sync .
Allows the mebile user to reinitialize the sync.
&
Clear Cache .
x Allows to clear transactional cache from the mobile application.
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It has two primary options:

Setting Description

Re-initiate Initial Sync Enables mobile users to trigger a full sync
with backend systems, useful when re-
solving sync issues or applying new con-
figurations.

Clear Cache Adds a "Clear Cache’ button in the mobile
app, allowing users to delete local data
(junk/temporary files) to improve perfor-
mance.

Once enabled and published the settings, they are applied to the selected product
(e.g. iMaintenance) within the mobile application.

16.2. Define Mobile Data Sync Preferences

This feature lets you optimize how data is synchronized to mobile devices—minimizing sync
times and improving app performance. Preferences can be set at tenant, plant, and role
levels.

To define mobile data sync preferences:

1. Expand Settings and click Mobile Data Preferences.
2. Select the Product (e.g. iMaintenance).
The screen appears with two tabs:

Tab Purpose

Global Data Define default data fields for each plant
(e.g. Maintenance Plant, Planning Plant)

Transactional Data Define sync filters for Work Orders and Is-
sues based on user roles

In this screen, you can,
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o Rename or remove fields

> Add new fields

> Reorder fields

o Configure sync durations per role

Example: Supervisors may sync 7 days of data, while Technicians sync 3.

Figure 16-2 Global Data

P Settings
==

Settings > Mobile Data Preferences

m
Product
mWorkOrder v
B
5,
A Global Data Transactional Data
Global Data Configurations
2 You can configure the global data fields for the mobile applications
* Main Plant
s
&
Planning Plant
'3
.
Maintenance Plant
* Main Work Center
= Settings
~ Settings > Mobile Data Preferences
m
Product
mWorkorder e
(=
S
A Global Data Transactional Data
Work Order Work Order
2 You can set filters to choose which transactional data related to Work Order will sync to the mobile application and define
default values as needed
Issues
*
Start Date Sync Period Last | 99 days To Next
&
N
A
B Issues
You can set flters to choose which traditional data related to issues will sync to the mobile application and define defauft
a values as needed

Start Date Sync Period Last | 99 days To Next

16.3. Apply Theme Configurations

Admins can customize the visual appearance of the iMaintenance mobile app using
predefined themes to match user environments or company branding.
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To apply theme configurations:

1. Navigate to Settings and click the Theme tab.

2. Select the Product (e.g., iMaintenance).

3. Choose a theme and click Publish.

R3

0

X

¢ ©

Figure 16-4 Theme Settings

Settings
Settings > General

Product
mWorkOrder M

Storage Theme

Theme Configurations
Choose Mobile Application Theme Mode  Dark, Light or System Default

(O System Default

(@ Light Mode

A A

Z INNOVAPPTIVE

() Dark Mode

A

You can choose from the following mobile theme modes:

Mode

Description

System Default

Uses the theme based on the user’'s de-
vice setting (light/dark mode)

Light Mode

Clean, bright interface with dark text—ide-
al for daylight use

Dark Mode

Low-light Ul for night shifts or dim envi-
ronments (e.g.,, mining, manufacturing)

Theme preferences apply globally for that product once published.
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17. Set Up Notifications

The Notification Engine gives administrators control over system-generated alerts, helping

teams stay informed about workflow events without being overwhelmed. It's integrated with

the iMaintenance mobile app, enabling flexible communication across devices.

17.1. Understand the Notification System

The notification system is built to support automated communication based on user actions

and workflow milestones. It uses third-party services for email delivery and is governed by

built-in templates and logic.

Key components:
Component Description
Recipients Defines who gets notified (e.g., assignees,
supervisors)
Timing When notifications are triggered (e.g., as-
signment, completion)
Content Predefined messages that communicate
what happened
Type The nature of the event (e.g, task assigned,
issue created)

These controls ensure that users receive timely alerts relevant to their role—improving

visibility without unnecessary noise.
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18. Build Dashboards and Reports

The platform offers robust tools to visualize, track, and analyze operational data through
customizable dashboards and reports. These tools help supervisors and technicians gain
real-time insights into asset health, work order status, performance metrics, and more.

This section has the following topics:

- View the Asset360 Dashboard (on page 137)
» Create Dashboards (on page 138)

» Add & Configure Widgets (on page 139)

» Create Custom Reports (on page 140)
 Archive & Share Dashboards (on page 142)

18.1. View the Asset360 Dashboard

The Asset360 Dashboard provides a 3600 view of real-time overview of work center and asset
performance, maintenance costs, resource utilization, work order status, workforce efficiency
and historical data for assigned plants. It helps supervisors make informed decisions by
tracking KPIs across various operational dimensions.

For example, Earlier, the supervisor worked in silos with delayed data, manual KPI tracking,
and reactive decisions. Cost visibility was limited, and ensuring compliance demanded
significant manual effort.

With Asset360 Dashboard, supervisors get a real-time, 360° view of their work centers—
spotting under-performing equipment or technicians. Powered by live data, Al-driven
insights, and role-based dashboards, it drives proactive, efficient, and audit-ready
maintenance operations and reduces overall maintenance costs.

Key actions available:

- Selecting Plants and Assets to track their performance.
« Viewing key metrics such as:
o Actual Maintenance Cost
> Planned Maintenance Cost
> Equipment Downtime
> Work orders with System Status, User Status, and Priority
o Issues with System Status, User Status, and Priority
> Mean Time To Repair
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- Customizing widgets (only title and color) and publishing updates.
« Downloading widget data for offline use.

« Archiving widgets that are no longer needed.

« Sharing dashboards via email using the Mail icon.

« Exporting dashboards as PDFs.

« Searching dashboards using the search bar.

P Dashboard 25 INNOVAPPTIVE
o » wyDushbonrd e
Proc
~ mWorkOrder v
e
All Dashboard + Asset360 ST
A Q <
B 1000 - Hamburg - 10257176 - Excavator-01 -
Asset360
2o
Mobile Dashboards 3 hours a0
Planned Maintenance Cost $1 49k Temperature @ hourssg .
* My Jobs
9°F
- Jobs At Risk
& .
Pressure (s hours ago) .
12PsI .\ ‘ Maintenance Plan (3)
5
£ 3M - Lubrication Check
® 6M - Pump Servicing
Measuring Point Trends 1Y - Overhauling
]
iPrnSSurn:‘ Temperature | Flow Rate Operating Hours
Last 6 month: hd
Last week A

-
You can modify only the title and color of the widgets and click Publish on the top
right. The changes made to the Asset360 Dashboard are reflected in the iMaintenance

mobile app.
N J

18.2. Create Dashboards

You can create custom dashboards tailored to operational needs, giving different user

personas visibility into the most relevant data.

To create a dashboard:
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1. Navigate to Dashboard > My Dashboard.
2. Click the Add (+) icon next to All Dashboards on the left panel.
3. In the Add New Dashboard window:

o Enter a title.

> Select a product (e.g., iMaintenance).

- Choose a category (e.g., Jobs at Risk, My Jobs).

> Add a description.

A Dashboard 25 INNOVAPPTIVE
| ectboard > iy st e
ccccccc
~ mWorkOrde hd
e
All Dashboard +  Asset360 = H
% et board  Add New Dashboard x
Q. Search <
Plnt .
B 1000 - Hamburg -
Asset360
5
Mobile Dashboards [ MU= A0 -
* My Jobs
% Jobs At Risk
A
“
* Cancel

No Data Found

4. Click Done to create the dashboard.
You can now begin adding widgets to the dashboard.

Tip: Fields marked with an asterisk (*) are mandatory and must be filled out to create a
dashboard.

18.3. Add and Configure Widgets

Widgets visually represent operational data on your dashboard using charts, tables, or KPIs.

To add a widget:

1. Navigate to Dashboard > My Dashboard.
2. Navigate to the Mobile Dashboards section, open your custom dashboard, and click
Add Widget.
3. Choose from:
> Pre-built Widgets: Ready-made visualizations that can be modified.
> Build Your Own Widget: Custom-built using your selected data fields.
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If using Pre-built Widgets:
> Select the module (e.g., iMaintenance.)
> Choose the object (e.g., Work Order, Issues.)
o Select data fields and click Add to Dashboard.
- (Optional) Modify the fields as needed.

If building your own widget:
> Select Module and Object (e.g.,, Work Orders, Operations).
o Enter widget title and description.
o Set visualization options:
= Widget size: Small, Medium, Large.
= Chart types: Bar, Pie, Donut, Line, Column, Table, etc.

= Legend colors for visual clarity.

X Add Widget . [~ |
Data Setup Preview

Basic Details Data Source

Widget Title * mWorkorder

Distribution by Priority

Chart Visuals

(S ponut Chart Pie Chart ®s High ® VeryHigh @ Medum

Number Chart
egend Colours
M1 W2 @3 W5 W6 M High M VeryHigh M Medium [l Low M Negligible

[ Add to Pre-built Widgets List

> Configure data:
« Data Settings: Define how data is sliced (e.g., by Priority).
= Data Filter: Apply filters like Priority, Assigned To Me, Created By Me.
= Preview the widget layout.
4. Click Add to save the widget.

18.4. Create Custom Reports

Reports allow you to generate detailed insights using business objects such as Work Orders,

Components, Operations, and Issues.

To create a report:
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1. Navigate to Dashboard > Reports.
2. Click Create Report.
3. In the Create Report window:
> Select the product (e.g., iMaintenance).
> Select the module (e.g., Operations).
o Enter report name and description.
> Click Continue.

Create Report

One step ahead for Report Creation

Product and Module which will fetch data for the Report

Product * - Module *
Name *

Description: *

4. In the Add Report screen:
- Edit the report name/description if needed.
> Use Group by Fields (e.g., Plant ID).
o Select Columns to display the report.
o Click Save.

@ Reports Z INNOVAPPTIVE
Dashboard > Reports > Add Report
Lo} Report Name
Q search 41k+ Records - o~ W
Operations Report. 7
e Report Description
Priority 11 e ERPWorkorder id 1 s Description 1 e Plantidn s MaintenancePlantid i ees  Name i
% Operations Report 7
OUTLINE FILTER The pump is not functioning
0126CC correctly, categorized as 1000 1000 Pump Malfunction Issue
B Group By Fields low priority
Q Add Group No Wo Comp Check
o Welding component.
ag Priority x 1100003 inspection for accuracy and 1000 1000 No Wo Comp Check
quality control
e Can:add only upto 3 Rows:
il Leakage Detection
Technical analysis of fluid
o Columns 1100004 loss and potential 1000 1000 Oil Leakage Detection
3 Q et cotmne containment strategies
o Pump Issue Reported The
Priority
P pump is not functioning as
1100005 expected, with no water 1000 1000 Pump Issue Reported
ERP Workorder Id flowing through the outlet.
Description Pump Issue Reported The
pump is not functioning as
— 1100006 expected, with no water 1000 1000 Pump Issue Reported
E 0D flowing through the outlet.
&4 Maintenance Plant Id
. 1100009 Pipe Breakage - Delta 1000 1000 Pipe Breakage - Delta
Name
‘Smart Home Automation
System Advanced control
U S 1100011 and monitoring system 1000 1000 Smart Home Automation
o incorporating IoT devices system
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You can also,
o Mark as Favorite.
o Search the columns.

o Filter by Date, Plant, Shift, Location, Equipment ID, etc.

> Use operators like equals, contains, greater than, etc.

> Download reports in CSV or Excel format.

- Use Undo, Redo, Sort, or More to hide/move/stick/group columns.

18.5. Archive and Share Dashboards

Archived dashboards, widgets, and reports help you de-clutter your workspace without losing

valuable data.

To manage archived items:

1. Navigate to Dashboard > Archive.

A Dashboard
X ouctboud » Achived

ashboard DO NOT CHANGE THIS

Jobs At Risk ‘The Default Dashboard DO NOT CHANGE THIS

2. Use the tabs to view:

- - o =

2 INNoVAPPTIVE

- Dashboards (includes name, description, widget count, archived date/by).

- Reports (includes module, description, modified by/on).
- Widgets (includes source, dashboard, archived by/on).
3. Use the search bar and column sorting to locate items.

4. Use the Actions menu to restore or delete items.
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